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1 Overview 
1.1 Fundamentals 
 

The OCI600 central communication unit is used for operating one or several heating 
and / or ventilation plants via a direct connection or connection via modem. 

The unit features an alarm function which is used to send fault status messages to 
different types of receivers (e.g. PC, mobile phone, pager, fax, etc.). 

The present Basic Documentation: 
• Gives an overview of the OCI600 central communication unit 
• Contains all information required for engineering and commissioning the OCI600 and 

the connected devices 
• Describes all ACS7... operating steps required in connection with the OCI600. 

For a complete description of ACS7... software operation, refer to Operating 
Instructions U5640, U5641 and U5642 (identical with Online Help of the ACS7… 
software package). 

1.2 Field of use 
 

The ACS7... / OCI600 system is for use in: 
• School buildings 
• Municipal buildings 
• Blocks of flats 
• Administrative buildings 

The ACS7... / OCI600 system is employed by: 
• Municipal administrations 
• Installation companies 
• School administrations 
• Real estate companies 
• General contractors 

1.3 System components  
    

The ACS7... / OCI600 system consists of the following components: 
• OCI600 central communication unit for the communication between a PC operator 

station and a heating or ventilation plant 
• Heating controllers, ventilation controllers, I/O modules, pulse adapters, temperature 

sensors / adapters 
 

• ACS7... software package for the remote operation of one or several OCI600 central 
communication units. One component of the ACS7... is the ACS Alarm software for 
the reception of alarms and system reports from one or several central 
communication units  

 

• LPB (Local Process Bus) 
 

Typical types of 
buildings  

Typical operators 

Devices 

Software 

Data bus 
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1.4 System-compatible devices 
 

The following LPB-compatible devices can be connected to the OCI600 central 
communication unit, enabling them to be integrated into the ACS7… / OCI600 system. 

1.4.1 Controllers 
 

Product line, series  Type 
reference 

Documentation 1) 

RVL469 N2527, P2522 
RVL470 N2522, P2522 
RVL471 N2524, P2524 

Heating controllers RVL4... 

RVL472 N2526, P2526 
RVP300 N2474, P2474 
RVP310 N2475, P2474 
RVP320 N2476, P2474 
RVP330 N2477, P2477 

Heating controllers RVP3... 

RVP331 N2478, P2477 
Energy managers RVP5… RVP5… N2488, P2488 

RVD230 N2383, P2383 District heating controllers RVD2... 
RVD240 N2384, P2384 
RVA43... P2371 
RVA46... P2372 
RVA47... P2379 
RVA63... P2373, P2374 
RVA65... P2392, P2393, P2394 

OEM heating controllers RVA... 

RVA66... P2378 
RVD235 G2385, P2383 OEM district heating controllers 

RVD2... RVD245 G2386, P2384 
RWI65... 2) Z3204 Ventilation controllers AEROGYR 
with AZI65.3 3) N3208 

1) N...= Data Sheet; P...= Basic Documentation; G…= Installation Instructions; Z...= Fundamentals 
2) No longer available 
3) LPB communication module 
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1.4.2 Other devices 
 

Type of unit Type 
reference 

Documentation 1) 

Pulse adapter with 2 inputs for 
consumption meters 

AEW2.1 N2831 

Temperature sensor / adapter 
with 2 inputs 

QAB30.600 N2528 

Input module with 4 inputs DOE4IN 3) – 2) 
Relay module with 4 inputs DOE4RE 3) – 2) 
Radio signal receiver AUF77 M5811 
Service unit AZW30 N2847, U2841 
Power supply unit PNE N8943 

1) N...= Data Sheet; M...= Mounting Instructions; U…= Operating Instructions 
2) For information about these modules, refer to chapter “10  Addendum” 
3) No longer available 

 

To do the addressing, both the AEW2.1 pulse adapter and the QAB30.600 temperature 
sensor / adapter need an address plug. The following sets of address plugs are 
available:  

Set of address plugs Type reference 
For address numbers 1...16 PTG1.16 
For address numbers 1...32 PTG1.32 
For address numbers 33...64 PTG1.64 
For address numbers 97...128 PTG1.128 

 

1.5 Documentation  
 

The following pieces of additional documentation on the ACS7… / OCI600 system are 
available: 

Type of documentation Ordering number 1) 
Data Sheet «Plant Operating Software ACS7…» N5640 
Operating Instructions «ACS Operating and ACS Service» U5640 
Operating Instructions «ACS Alarm» U5641 
Operating Instructions «ACS Batchjob» U5642 
Data Sheet «Central Communication Unit OCI600» N2529 
User Manual «Central Communication Unit OCI600» U2529 2) 
Operating cards «Central Communication Unit OCI600» B2529 2) 
Data Sheet «Local Process Bus LPB, Basic System Data»  N2030 
Data Sheet «Local Process Bus LPB, Basic Engineering 
Data» 

N2032  

Basic Documentation «LPB System Engineering» P2370 
1) N...= Data Sheet; U…= Operating Instructions; B…= Operating Instructions; P...= Basic Documentation 
2) Operating cards and User Manual are supplied in the form of sets (ordering number ARG600.EN) 
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1.6 Communication 
 

The OCI600 central communication unit is a connecting link used to operate LPB 
devices and the OCI600 itself via the ACS7…software installed on a PC and to forward 
alarms from the LPB devices and the OCI600 to different types of receivers. For that 
purpose, the OCI600 offers 2 connecting choices: Direct connection via its RS-232 port 
or connection via modem. 

1.6.1 Direct communication 
 

The connection between OCI600 and operator station (PC with ACS7... software) is 
established via an RS-232 cable. For that connection, a standard null modem adapter / 
cable or link cable is used. 
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1.6.2 Communication via modem  
 

The connection between OCI600 and operator station (PC with ACS7…software) is 
made via the telephone network. 

 
 

1.7 Important note 
 

Where indicated, the adjacent symbol draws your attention to special safety notes and 
warnings. If not observed, injury to persons and / or considerable damage to property 
can occur. 
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2 Local commissioning 
 

The system must be commissioned by authorized technical staff. 

2.1 Mounting 
 

All devices must be mounted in accordance with the relevant Data Sheets and 
Mounting Instructions. 

2.2 Electrical installation 
 

The following installation work must be performed prior to commissioning the system: 

1. Connect the following types of devices and components to AC 230 V mains 
voltage: 

• Controllers (excluding the RWI65…) 
• Batibus modules 
• Modem mains unit 
• AC 24 V transformers 

2. Connect the following types of devices and components to AC 24 V: 
• Central communication unit OCI600 
• Pulse adapter AEW2.1  
• Temperature sensor / adapter QAB30.600  
• Ventilation controller RWI65... 

The RWI65... ventilation controller must be connected so that it is galvanically 
separated from all other components. For this reason, a separate AC 24 V transformer 
is required. 

3. Lay the LPB bus line between the OCI600 central communication unit and the 
plant’s LPB devices (do not connect it yet). 

User Manual U2529 contains the connection diagram for the OCI600. 

2.3 Setting up the individual components 
2.3.1 Setting up the controllers 
 

The setting up procedure depends on the kind of bus power supply: 

• Decentral bus power supply by the controllers, or 
• Central bus power supply by the OCI600 

Each time a device has been connected, the voltage across the bus is to be checked to 
make certain there is no false wiring. If several devices are connected before a check is 
made, false wiring is difficult to detect. 

The LPB Basic Documentation (P2370) contains detailed commissioning instructions 
for the LPB with decentral bus power supply by the controllers. 

If an OCI600 is connected to the bus, its power supply is used for the bus. The basic 
procedure is the following: 

 Switch off bus power supply on the controllers 
 Enter the addresses in the controllers  
 Switch on bus power supply on the OCI600 
 Enter the controller addresses in the OCI600  

 

Mains connections 

Transformer 
connections 

 

LPB 

Tip 

Tip 

Decentral bus  
power supply 

Central bus  
power supply 
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This means in detail: 
1. Ensure that all controllers have the LPB connection removed. 

 Switch off power supply of the relevant controller 
 Remove the controller from its base 
 Disconnect the LPB connection 

2. Put all controllers autonomously in operation. 
 Switch on power supply of the relevant controller 
 Enter the controller’s device and segment address 
 Switch off controller’s bus power supply (set the controller’s parameters as 

described in its Installation Instructions) 
 Do not yet establish the LPB connection 

3. Set the parameters of the OCI600. 
 Activate the central bus power supply on the OCI600, operating card 3, line 

number 07 
In large plant with central bus power supply and simultaneous bus power supply via the 
controllers, overcurrents on the bus can occur! For any damage resulting herefrom, 
Siemens will not assume responsibility. 
4. Connect the controllers to the LPB, one by one. 

 Observe the polarity and check the bus voltage each time a device has been 
connected, thus avoiding wiring errors: The voltage must be a minimum of DC 
+9.5 V at any point of the network (DB+, MB–) 

2.3.2 Setting up the AEW2.1 pulse adapter  
 

The AEW2.1 pulse adapter is to be set up with the help of the AZW30 service unit. 
SYNERGYR User Manual U2841 contains detailed information about the AZW30. 

To set up a pulse adapter, a PTG1… address plug set is required. 

Permissible addresses if… 
an OCI600 is 
connected to the bus 

an OCI600 and an OZW30 are connected to the bus 

1, 3, 5, 7, 9, 11 
(PTG1.16) 1) 

121...126 
(PTG1.128) 2) 

1)  6 pulse adapters with 2 inputs can be parameterized on the OCI600 

2)  3 pulse adapters with 2 inputs or 6 pulse adapters with 1 input can be used with the OCI600 

When using addresses 124, 125 and 126, only the inputs “Counter 1 (P1–M)” may be 
used with the pulse adapters. 

Pulse adapter 
address plug 

Counter number and 
counter connection 

Counter number on the central 
unit (apartment 0) 

Counter 1 (P1–M) Counter 1 121 
Counter 2 (P2–M) Counter 2 
Counter 1 (P1–M Counter 3 122 
Counter 2 (P2–M) Counter 4 
Counter 1 (P1–M) Counter 5 123 
Counter 2 (P2–M) Counter 6 
Counter 1 (P1–M) Counter 2 124 
Counter 2 (P2–M) – 
Counter 1 (P1–M) Counter 4 125 
Counter 2 (P2–M) – 
Counter 1 (P1–M) Counter 6 126 
Counter 2 (P2–M) – 

Addresses 1...48 must not be used because they are in the area of the apartments with 
the OZW30. 

Procedure 

 

Service unit 

Note 
Addressing 
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If several OCI600 (maximum 4) are connected to the LPB, the same regulations apply 
when assigning addresses. Every address can be assigned only once. 

1. Connect the AZW30 service unit to the service interface of the pulse adapter 
whose parameters shall be set. 

2. Check wiring with the help of the LED on the pulse adapter: 
LED flashes LED off LED steady on 
Normal 
operation 

No power (G1 and 
G2: AC 16...24 V) 

• No address plug 
• Wiring error, MB and DB mixed up 
• No bus power supply 
• Poor contact 
• Type of pulse source (line 91) incorrectly 

parameterized: With Namur circuit (01) in 
place of without (02) when Reed contact is 
used 

• Open-circuit or short-circuit at counter 
connection with Namur circuit (01) 

3. Ensure that on applications with the OCI600 central communication unit, the 
subaddress is always kept at 1. 

4. If required, enter the device number (AZW30 line number 01).  
5. Enter the counter parameters (AZW30 lines 86, 87, 88, 90, 91). You have 2 

choices:  
• You enter the parameters one by one 
• If the parameters were previously stored in the service unit, you can copy them 

to the pulse adapter. 
To do this, proceed as follows: 
• Select AZW30 line number 53 (writing the standard data set) 
• Press simultaneously buttons  and  on the right for 2 seconds 
• Adjust the parameters, if required 

6. Enter the current counter reading (AZW30 line number 02). 
7. Store the data set of the counter just parameterized. Proceed as follows: 

• Select AZW30 line number 95 
• Press simultaneously buttons  and  on the right for 2 seconds. 

The data will be assigned to counter 3 of the apartment. In the next apartment, 
the data can be copied to the respective pulse adapter and then adapted 

8. Repeat these steps with all counters located in the apartment. 

 

Procedure  
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2.3.3 Setting up the QAB30.600 temperature sensor 
 

To set up a QAB30.600 temperature sensor / adapter, a PTG1… address plug set is 
required. 

Permissible addresses if… 
an OCI600 is connected to the 
bus 

an OCI600 and an OZW30 is connected to the bus 

13, 15  (PTG1.16) 1) 125, 127  (PTG1.128) 1) 
1) 2 temperature sensors with 2 inputs can be parameterized 
 

1. Fit the address plugs in accordance with flow zone numbers 1 and 2. If only an 
OCI600 central communication unit is connected to the bus, address plugs 13 and 
15 are to be used. If, in addition, an OZW30 central unit is connected, use address 
plugs 125 and 127. 

2. Check wiring with the help of the LED on the temperature sensor / adapter: 

LED flashes LED off LED steady on 
Normal 
operation 

No power supply  
(G1 and G2: AC 16...24 V) 

• No address plug  
• Wiring error, MB and DB mixed up 
• No bus power supply 
• Poor contact  
• Sensor error 

3. Connect the temperature sensor to the bus. 
4. Check to ensure that the protection pocket is correctly mounted. 
5. Check to ensure that the immersion sensor is correctly mounted. It must be fully 

immersed in the protection pocket. 
6. Secure the immersion sensor using the adjusting screw on the protection pocket. 

2.3.4 Setting up the DOE4IN input module 
 

1. Check wiring with the help of supplier’s specification.  
2. Select address by turning the appropriate setting knob:  

• The segment number with the knob at the top  
• The device number with the knob at the bottom  

3. Connect the input module to the LPB.  
4. Check the connection: The orange LED flashes in normal operation. 

2.3.5 Setting up the DOE4RE relay module 
 

1. Check wiring with the help of supplier’s specification.  
2. Using a screwdriver, set all outputs to “Auto”.  
3. Select address by turning the appropriate setting knob: 

• The segment number with the knob at the top  
• The device number with the knob at the bottom  

4. Connect the relay module to the LPB.  
5. Check the connection: In normal operation, the orange LED flashes. 
 

Addressing 

Procedure 

Procedure 

Procedure 
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2.4 Engineering the bus with the OCI600 
2.4.1 Key components 
 

The number of OCI600 central communication units the ACS7… software can monitor 
and control are unlimited. However, several plants cannot be accessed at the same 
time.  

The ACS Alarm software registers alarms from any number of central units like the 
OCI600. Using different COM ports, it is possible to simultaneously receive alarms via 
modem and direct communication. 

Up to 4 OCI600 central communication units can be connected. But if, in addition, an 
OZW30 central unit is connected to the LPB, only 1 OCI600 can be used. 

2.4.2 Addressing the LPB devices 
 

Addressing of the input modules and relay modules takes place by setting segment and 
device addresses. For more information about the Batibus modules, refer to section 
“10.1 Batibus modules”. 

For the maximum number of pulse adapters and their addressing, following applies:  
• If no OZW30 central unit is connected to the LPB, up to 6 AEW2.1 pulse adapters 

can be connected to the LPB and operated via the OCI600. In that case, addresses 
1, 3, 5, 7, 9 and 11 will be used  

• If, in addition to the OCI600 central communication unit, an OZW30 central unit is 
connected to the LPB, a maximum of 6 AEW2.1 pulse adapters can be connected to 
the LPB – in addition to the pulse adapters in the SYNERGYR apartments. For the 
assignment of the AEW2.1 pulse adapters to the OCI600, address plugs 121…126 
are reserved. 
For more detailed information about the AEW2.1 pulse adapter, refer to Data Sheet 
N2831. 

A maximum of 2 temperature sensors / adapters can be connected directly to the LPB 
to be read via the OCI600.  
• If no OZW30 central unit is connected to the bus, addresses 13 and 15 are reserved 

in the OCI600  
• If, in addition, an OZW30 central unit is connected to the bus, address plugs 125 and 

127 are reserved for assigning the QAB30.600 temperature sensors / adapters 
For more detailed information about the QAB30.600 temperature sensor / adapter, refer 
to Data Sheet N2528.  
 

Administration of  
several plants 

Reception of alarms 

Maximum plant size 

Batibus modules  

Pulse adapter  
AEW2.1 
 

Temperature sensor / 
adapter QAB30.600 
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2.4.3 Maximum number of LPB devices per OCI600 
  

The OCI600 central communication unit is designed such that with each of them, the 
following maximum numbers of devices can be interconnected via LPB to form a system: 

Type of device Max. number
Siemens HVAC controllers 16 
Pulse adapter AEW2.1 6 
Temperature sensor / adapter 
QAB30.600 

2 

Input module DOE4IN 4 
Relay module DOE4RE 4 

 

2.4.4 Powering the LPB devices 
 

The LPB devices operate on the following voltages:  

AC 230 V mains voltage connections are to be provided for the:  
• Controllers (excluding the RWI65...) 
• Standard Batibus modules 
• Modem mains unit  
• AC 24 V transformers  

AC 24 V connections are to be provided for the:  
• Central communication unit OCI600  
• Pulse adapter AEW2.1  
• Temperature sensor / adapter QAB30.600  
• Ventilation controllers RWI65... 
 
The RWI65... ventilation controller must be connected such that it is galvanically 
separated from all other components. For this reason, a separate AC 24 V transformer 
is required. 
 

AC 230 V 

AC 24 V 
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2.5 General information on bus engineering 
2.5.1 Functional principle of LPB 
 

The LPB is based on the Batibus protocol standard with company-specific extensions. 
It makes use of the CSMA / CA (Carrier Sense Multiple Access / Collision Avoidance) 
procedure. This procedure implies that each bus user is equal in terms of data 
transmission and there is no communication master (in contrast to the master / slave 
principle). Data are directly exchanged between bus users (peer-to-peer 
communication). 

If several bus users want to deliver a message at the same time, special mechanisms 
prevent data collisions on the bus. The telegram of one sender will be correctly 
transmitted. The other senders stop their transmission and make another transmission 
attempt on completion of a certain waiting time. 

The CSMA / CA procedure offers short waiting times if the available bus transmission 
capacity is used within permissible limits. The bus loading is dependent on the number 
of connected devices. 
When using a central bus power supply, coexistence of LPB devices and Batibus 
modules is ensured. 

2.5.2 Procedure for engineering 
 

Step Action Objective 
Hydraulics 1 Understand the situation − Overview of hydraulics 

2 Develop solutions − Detailed plan of plant including 
location of buildings and 
arrangement of rooms 

3 Take a closer look at potential 
extension zones and extensions 

− Design plant in a way that it 
can be extended later 

Control 4 List potential mounting locations and 
applications of devices 

− Entry in plant diagram 
− List of applications 

5 Determine number and types of 
devices 

− Table of device types 
− Number of devices  

Communication 6 Select cable routing − Entry in plant diagram 
7 Determine cable lengths − Entry in plant diagram 
8 Determine bus dimensions − Cross-sectional area 

− Bus extension 
9 Determine type of bus power supply − Type of power supply  

− Location of power supply 
10 Consider limitations − Adapt bus sizing or bus power 

supply  
11 Draw block network plan and 

connection diagram 
− Commissioning documentation  
− Plant documentation  

 
When designing plant, it is especially the following factors that determine the plant’s 
extension:  
• Type of cable 
• Number of devices 
• Total cable length 
• Type of bus power supply 
For more detailed information, refer to subsections “2.5.7 Bus power supply” and “2.5.8 
Bus sizing”. 

Basic principle 

Standard procedure 
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2.5.3 Addressing guidelines  
 

To enable the different devices of the plant to work together and to exchange data via 
bus, they must be addressed. The bus address facilitates communication and defines 
the device functions within the plant. 

The address consists of a segment address and a device address. 
In principle, the devices are always addressed in the direction of heat flow, but 
considering the location of the outside sensor.  

Each address in an LPB system may be assigned only one. 

The segment address is used for structuring a bus system. Typical structuring criteria 
are the following:  

• Location of the plant or building (e.g. 1 segment per building)  
• Flow temperature (e.g. all floor heating groups in 1 segment) 
• Simultaneousness (e.g. all groups that require energy within the same period of time) 

Within the system, a maximum of 15 segments (including segment 0) can be created. 
Controllers in the same segment must be assigned to the common flow.  
Some of the addresses are reserved for certain applications. This must be taken into 
account when assigning addresses and when doing engineering work: 

Segment 
number 

Function 

0 Central segment:  
• This segment is used for central heat generation (with boiler 

sequencing) which can be the heat source for all segments  
• But it can also be used like segment 1…14  
• The OCI600 is firmly assigned to segment 0 

1...14 Additional segment addresses: 
• These addresses are used for subdividing a plant into segments, e.g.: 

− Per heating group with the same flow temperature 
− Per building 

• Each segment can contain a heat source and take into consideration 
its own demand only. In that case, central heat generation is not 
possible! 

Consumers in segments 1…14 automatically pass on their heat demand to central 
segment 0. 

If the LPB is used for the supervision of several functionally independent heating plants, 
central segment 0 must not be used for addressing a heat source. 
 

General 

Segment address 



19/88 

Building Technologies Central Communication Unit OCI600 CE1P2529en 
HVAC Products 2 Local commissioning 09.01.2006 

  
The device address is used for designating the devices in a segment. 
Some of the addresses are reserved for certain applications. This must be taken into 
account when assigning addresses and when doing engineering work:  
 

Device 
number 

Function 

0 No communication 
1 Master: 

• This device address is used for the segment master 
• In each segment, there must be a device as a master with device 

address 1 
2...16 Additional device addresses: 

• These addresses are used for structuring the devices within a segment 
• The addresses must be assigned in the direction of heat flow: First 

heat generation, then heat distribution 
5...8 Central communication unit OCI600: 

• If an OCI600 is used in the system, the device address must always lie 
between 5 and 8 

 
Depending on the design of the plant, the segment master provides the following 
function:  
• In one of the consumer segments, the segment master becomes the consumer 

master  
• In one of the heat source segments, the segment master becomes the heat 

generation master  

The assignment of addresses must not necessarily be in consecutive order. If 
extensions are planned, for instance, gaps may be left. But the segment master (device 
address 1) must not be skipped. 

Device number 
1 2 Reserved Reserved 5 6 

      
Segment master      

 
 

The value of the outside sensor will be adopted by the controller that has an outside 
sensor connected which, in terms of addressing, is the next lower controller. A common 
sensor can be used for all controllers, or groups of controllers can use 1 sensor. In that 
case, addressing must take place based on the location of the outside sensor (refer to 
section «Addressing guidelines»).  
If there is no controller with an outside sensor which – in terms of addressing – is lower 
(e.g. in the case of the device with the address 0/1), the value of the highest outside 
sensor will be used (e.g. 14/16). 

When commissioning a controller with no outside sensor, the display will show error 
code 10 (error outside sensor) until an outside sensor value can be adopted via LPB. 

With cascaded boilers, the common flow temperature sensor is used by all boiler 
controllers. It must be connected to the heat generation master (device address 1).  

Some of the LPB controllers can provide acquired sensor values (e.g. the flow 
temperature) via LPB to the other controllers. These values can be used by all 
controllers located in the same segment. In each segment, only 1 controller may 

Device address 

Example 

Common measured 
values 
Outside sensor 

Common flow sensor 

Other sensor values 
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distribute the value of the same type of sensor on the bus (with the exception of the 
outside sensor). 
 

To be in accordance with the time of day within the system, one of the devices must be 
defined as the clock time master. Only 1 device per LPB system can be defined as the 
clock time master. 
The clock time master function can be provided by the OCI600 central communication 
unit, an AUF77 radio signal receiver, or a controller. 

The boiler controllers are supplied with setting 3 (= system clock, master), and the 
consumer controllers with setting 0 (= autonomous clock). For a detailed description of 
the 4 different clock operating modes, refer to the Basic Documentation of the relevant 
device. 

The system time can be predefined by the AUF77 radio signal receiver (for detailed 
information, refer to Mounting Instructions CE1M5811X). This receiver can be 
connected to the LPB at any location. It transmits to the system the time it has 
received. For this reason, with all controllers and the OCI600 central communication 
unit, setting 1 or 2 must be selected on operating line Clock Operation (clock time of 
LPB = system time, no clock time master). In terms of the number of devices that can 
be connected to the LPB, the radio signal receiver is regarded as 1 device. Power is 
supplied via LPB. Addressing is not required. 
When using the radio signal receiver, the system time always accords with the time of 
the atomic clock of the radio signal center in Frankfurt. The change from summer- to 
wintertime takes place automatically, and leap years and leap seconds are also taken 
into account. A switch on the AUF77 radio signal receiver permits time zone 
adjustments by ±1 hour. 
 

Clock time 
synchronization 
System time 
 

Basic time 

Radio signal receiver 
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2.5.4 Addressing examples 
  

 

Segment address 0 0  0 0 0 0 0  1  2 2 
Device address 1 2  3 4 6 16 5  1  1 16 
Outside temperature adopted from B9 0/1  0/1 0/1 0/1 0/1 –  B9  1/1 1/1 

 
 
A heat source generates the heat for the entire heating plant. Outside sensor B9 is 
connected to the heat source (address 0/1) and forwards its measured value via LPB to 
the other devices. 

The consumer controllers always use the sensor value of the controller that has the 
next lower address. In the above example, controllers 0/1 through 0/16 use the value of 
the outside sensor connected to controller 0/1 (heat source controller). Controllers 1/1 
through 2/16 use the value of the outside sensor connected to controller 1/1. 

The OCI600 central communication unit is optional and facilitates remote supervision of 
the plant, among other functions. The OCI600 is capable of transmitting plant 
malfunctions to the ACS Alarm software. 
 

Heat generation with 
several consumers 

Heat generating 
equipment 

Heat consumers 

Central communication 
unit OCI600 
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1

3

2

0

LPB

25
29

Z1
8e

B10
B9 B9

Building A Building B Building C Building D

B9 B9
B10

OCI600

Segment address 1 1  0 0 0 0  0  2  3 3 
Device address 1 2  1 2 3 6  5  1  1 2 
Outside temp. adopted from 0/1 0/1  B9 0/1 0/1 0/1  –  B9  2/1 2/1
               
    Cascading         

 

Cascading is only possible with OEM controllers. 

The 3 heat sources are cascaded (cascading is only possible in segment 0). Outside 
sensor B9 and the common flow sensor (cascade sensor) B10 are connected to the 
heat generation master (address 0/1). 

The cascade sensor (B10) must be connected to the heat generation master. The heat 
generation master has segment / device address 0/1. 

The consumer controllers use the sensor value of the controller with the next lower 
address. Hence, the consumers in segments 0 and 1 use the value of the outside 
sensor connected to controller 0/1, and the consumers in segments 2 and 3 use the 
value of the outside sensor connected to controller 2/1. 

The OCI600 central communication unit is optional and facilitates remote supervision of 
the plant, among other functions. The OCI600 is capable of transmitting plant 
malfunctions to the ACS Alarm software. 
 

Cascaded heat 
generation with 
consumers in  
different buildings 

Note  

Heat generating 
equipment 

Important 

Heat consumers 

Central communication 
unit OCI600 
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B9

B2B2

B10

B9 B9
B10

B9

B9 B9

Segment 1 Segment 2 Segment 3

2529Z19

Segment 0

LPB

OCI600

Segment address 0 0  1 0 1 1 2 2 3 3 
Device address 1 2  1 5 2 3 1 2 1 2 
Outside temp. adopted from B9 0/1  B9 – 1/1 1/1 B9 2/1 2/1 2/1 
            
 Cascading         

 

Cascading is only possible with OEM controllers. 

The 2 heat sources are cascaded (cascading is only possible in segment 0). Outside 
sensor B9 and the common flow sensor (cascade sensor) B10 are connected to the 
heat generation master (address 0/1). 

The cascade sensor (B10) must be connected to the heat generation master. The heat 
generation master has segment / device address 0/1. 

The consumer controllers use the sensor value of the controller with the next lower 
address. Hence, the consumer controllers 1/1 through 1/16 use the value of the outside 
sensor connected to controller 1/1, and the consumers in segments 2 and 3 use the 
value of the outside sensor connected to controller 2/1. 

With the following types of controllers, a second distribution level (segment 1, controller 
1) can be created: 

• RVA66.540  
• RVL470, RVL471, or RVL472  
• RVP300, RVP310, RVP320, or RVP330  

Also, when using the following types of controllers on the second distribution level, 
control of DHW heating can be provided: 
• RVA66.540  
• RVL471, or RVL472  
• RVP310, RVP320, or RVP330  

The OCI600 central communication unit is optional and facilitates remote supervision of 
the plant, among other functions. The OCI600 is capable of transmitting plant 
malfunctions to the ACS Alarm software. 

Cascaded heat 
generation with 
consumers on 2 
distribution levels 

Note 

Heat generating 
equipment 

Important 

Heat consumers 

Central communication 
unit OCI600 
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2.5.5 Bus topology 
 

The following types of bus topology are permitted:  
• Line topology  
• Tree topology  
• Star topology  
• Combinations of these 3 topologies  
For lightning protection reasons, ring topology is not permitted 

 
Line topology Tree topology Star topology 
 

25
29

Z2
8

 
Ring topology 

If the bus is laid outside the building, special attention must be paid to lightning 
protection. 
In most cases, a combination of line, tree and star topology is advantageous. The ideal 
topology is dependent on the object, however, and should therefore be decided upon 
on a case-to-case basis. In general, the tree topology is best suited for more extensive 
plant. 
To facilitate fault tracing, detailed documentation of every plant should be produced, 
showing the bus structure, and a plan showing the location of the connection boxes. 
The cables used should be clearly marked where the connections are made. In the 
case of larger plant, it is advisable to write down the cable lengths and the measured 
line resistances. 
 

General 
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2.5.6 Installation in compliance with EMC directives 
 

Devices must be installed according to supplier specifications and in compliance with 
local regulations and standards. 
The following rules are of general nature and do not represent specific requirements 
placed on the installation of Siemens HVAC devices. The specific instructions to be 
observed will be found in the Installation Instructions for the relevant product, which 
may not necessarily accord with the information given here. 

Term Definition Comment 
Grounding Electrically conductive connection 

of devices with a reference ground 
Grounding is the most important 
measure since additional 
measures such as shielding or 
filtering only work properly when 
grounding is effective 

Reference 
ground 

Grounding system that satisfies 
high frequency requirements, 
aimed at diverting interference 
currents to ground 

Cable ducts made of metal and 
equipotential bonding systems 
are part of the reference 
grounding system 

Earth Electrical connection of one point 
of the operating circuit or of a 
metal component to the protective 
earth (PE) 

 

Earthing The sum of all earthing measures Earthing protects people. It is 
normally achieved by means of 
the protective earth (PE) wire, 
which is green / yellow 

Looped area Area created between cables and 
the reference ground (common 
mode coupling) or between 2 
cables (differential mode coupling) 

 

  
Every mains cable can produce interference. Short-time voltage surges, so-called 
transients, are caused primarily when switching inductive loads. Examples of inductive 
loads:  
• Industrial relays  
• Motors  
• Contactors  
• Pumps  
• Magnetic valves  
• Fluorescent lamps  
These surges have a capacitive effect on neighboring signal or bus cables and lead to 
interference in plant or sections of plant. In practice, the level of interference depends 
on the way the plant is installed. As a result, the risk of encountering EMC problems 
depends on a number of factors.  
 

Introduction 

Glossary  

Background 
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N1 N2

M

Z

i

C

M

2034S01

s
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E

MSF

SF

is

isis

 
Principle of common mode coupling. The interference field includes interference 
currents on the signal transmission line. 
N1 Controller 1 M Ground 
N2 Controller 2 MSF Decisive looped area for coupling from the field 
is Interference current SF Electromagnetic interference field 
Cs Stray capacitance ZE Earth resistance 
 

Measures to fight EMC problems: 
• Prevent sparks on electrical contacts by using spark quenching devices  
• Reduce the looped areas between cables and between cables and reference ground 

by choosing appropriate cable routing (also refer to the following section «Cable 
routing» 

• Use shielded and twisted bus and signal cables (also refer to the following section 
«Cable shielding») 

 
Signal and bus cables should always be routed separate from power cables, observing 
an adequate clearance. Too great distances create too large looped areas, however, 
which in turn favor couplings from the field caused by lightning currents or mobile 
phones, for instance.   

2 controllers with bus connection located in the same building. The bus cable is laid far 
away from the mains power cable, e.g. on the opposite side of the building. This results 
in a large looped area and, therefore in a considerable interference. 

N2

V1 V3 V2

20
34

S
03

N1

Bus

Bus Bus

 

N2

V1 V3 V2

20
34

S
02

N1

Bus

Bus Bus

Preferred cable routing due to reduction 
of looped areas 

Unsuited cable routing 

N1 Controller 1 V3 Control panel 
N2 Controller 2  Bus cable 
V1 Conduit box 1  Mains power cable 
V2 Conduit box 2  Looped area 
 

Cable routing 

Example 



27/88 

Building Technologies Central Communication Unit OCI600 CE1P2529en 
HVAC Products 2 Local commissioning 09.01.2006 

To lay the cables in compliance with EMC directives:  
• Lay cables together, but always observe a distance of 15 to 20 cm! 
• Do not lay signal and mains power cables in the same plastic duct  
• Cables from controllers to pumps, burners, actuators, etc. are also considered as 

mains power cables that cause interference  
• Wherever possible, lay the cables on reference ground. Suited for that purpose are 

metal cable ducts that are properly interconnected electrically, both between 
themselves and against reference ground 

• Metal cable ducts reduce the looped area against ground 
 

N2

V1 V3 V2

20
34

S
04

N1

 

Reduction of looped areas, optimum cable routing in metal cable ducts 
N1 Controller 1  Bus cable 
N2 Controller 2  Mains power cable 
V1 Conduit box 1  Metal cable duct 
V2 Conduit box 2  Looped area 
V3 Control panel   

 

 

• Shielded cables offer good protection 
• Braid shielded cables with good coverage afford the best protection. Important is the 

proper protection of the cable shield at both ends 
• Foil shielded cables should not be used 
• Twisted pairs of wires reduce differential mode coupling. Common mode interference 

currents (interference caused by inductive loads) are not reduced however 

Example of suitable measures aimed at achieving immunity against radiated and 
inductive coupling. The cable shield is connected to ground at both ends. The cable 
shield keeps the interference field away from the signal cable or diverts it to ground. 
 

Cable shielding  

Notes 

Examples 
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N1 N2

M

Z
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M

2034S05
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N1 Controller 1 MSF Decisive looped area for coupling from the field 
N2 Controller 2 KS Cable shield impedance ≅ 0 Ω 
is Interference current SF Electromagnetic interference field 
Us Interference voltage ZE Earth resistance 
M Ground   

 
Example of suitable measures aimed at achieving immunity against capacitive 
coupling. The cable shield is connected to ground at both ends. The cable shield keeps 
capacitive coupling away from the signal cable or diverts it to ground. 

N1

M

Z

i

M

2034S06

s

E

~ 0
Us

i s1 is2

is N2

 
N1 Controller 1 Us Interference voltage 
N2 Controller 2 M Ground 
is Interference current ZE Earth resistance 
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• The whole circumference of the cable shield must be properly connected to 
reference ground using a flat surface (equipotential bonding = building ground, 
control panel ground, etc.) at both ends 

• It is recommended to connect the cable shields to the ground rail or metal mounting 
plat using suitable clamps 

 

20
34

Z0
1

3 4

1 2

 

Connection of cable shield 
1 Protective earth terminal 
2 Cable clamp  
3 Rail 
4 Metal plate 

 

20
34

Z0
2

1

23 4  

Connection of cable shield 
1 Ground rail 
2 Cable clamp 
3 Good 
4 Better 

 

20
34

Z0
3

1

2  

Unsuited connection of 
cable shield by so-called 
pigtails 
1 Shield 
2 Pigtails 

 
• The clearance required between correctly shielded cables and parallel running mains 

power cables may even be zero. It is better, however, to observe a distance of about 
15 cm 

• Shielded cables to room units: in general, proper grounding at the room unit is not 
possible. For this reason, the cable shield is connected to the ground only at the 
controller 

• Unshielded cables are much more susceptible to interference than shielded cables. 
Both wires should be twisted 

• If there are parallel running mains power cables, a distance of 15 to 20 cm is 
mandatory 

• It is recommended to rout power and signal cables in metal cable ducts 
• If plastic ducts are used, signal and power cables must be laid in separate ducts 

observing a distance of 15 to 20 cm 
• In situations which are difficult from the point of view of EMC, it is recommended to 

use shielded power cables for motors, actuators, etc.  
• In the case of power cables for frequency converters, shielded cables are strongly 

recommended. Such cables are available as mineral insulated copper-clad cables 
(MICC), for instance 

• The shield of such cables must be properly connected to ground at both ends 
• Metal cable ducts afford very good immunity against interference because the signal 

cables or mains power cables are laid on the reference ground. The looped area 

Mounting the cable  
shields 

Shielded cables 

Unshielded cables 

Power cables 

Cable ducts 
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against the ground is thus reduced, provided the individual sections are electrically 
properly interconnected via large surfaces 

• Cable ducts must be connected to the reference ground = equipotential bonding 
every 20 m, but at least once on every floor 

• If mains power and signal cables must be run in the same cable duct, the duct must 
be made of metal and be closed on three sides (see illustration). The metal partition 
in the middle separates the mains power cables from the signal cables  

 

23
70

Z2
0

S N

M

 

S Signal lines 
N Mains power cables 
M Metal duct with metal partition 

  

• Wherever a bus cable enters or leaves a building, the proper installation of a surge 
protector against lightning effects is mandatory 

• The proposed surge protector does not offer protection against constant 
overvoltages (mains voltage) and surges that affect the terminal units via the building 
installation (water pipes or mains connection) 

• The bus cable should enter the building where the mains cable enters (single-point 
entry) 

• Equipotential bonding system = reference ground must be fitted very close to the bus 
cable entry  

• The surge protector must be mounted on a DIN rail that is to be connected to the 
equipotential bonding system using a short piece of copper (20 x 2 mm) to ensure 
good conductance  

• Note: The surge discharge current flows via the fixing of the surge protector to the 
DIN rail. Without this connection, there will be no protection! 

• Each building requires a surge protector, such as the protector supplied by 
PHOENIX, which consists of a UFBK-M 2-PE-48AC-ST plug-in unit (3-step surge 
protector) and a UFBK BE basic unit (decoupling). Siemens has approved this type 
of surge protector for use with the LPB and M-bus 

• The unprotected bus cable input must be connected to terminals 1 and 2 marked 
«IN», the protected bus output to the controller to terminals 3 and 4 marked «OUT») 

• Planning the bus topology: the capacity of 2.3 nF per surge protector must be 
included in the permissible capacitive bus loading 

• At the point of entry to the building, the cable shield must be connected to the 
equipotential bonding system while ensuring good conductivity 

• In normal situations, a TN-S mains network with separate protective and neutral 
conductors is now used. With buildings located in the same area, equipotential 
bonding is provided by the earth conductor 

• Armored mains supply lines must be properly connected to the equipotential bonding 
system where the supply lines enter the building 

• In the case of long distance connections, equipotential bonding from one building to 
another is no longer ensured. In that case, only one side of the shield is to be 
earthed 

Bus connections 
between buildings 
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BUS  OUT

W

E

A

BUS  IN N

PAS
FUE

20
34

Z0
4

SPE

TFS TRA

 
N Controller FUE Foundation earth 
W Water pipe PAS Equipotential bonding system 
E Power cable TRA Surge protector 
A Antenna cable BUS IN Unprotected 
SPE Single-point entry BUS OUT Protected 
TFS Separate spark gap   

 
 

Metal mounting plates or the rear of control panels are the reference point for the cable 
shields and housings. They must be capable of decoupling interference and of short-
circuiting interference voltages.  
• Interior walls should not be painted 
• Interior walls should be galvanized as standard (to provide protection against 

corrosion) 
• Grates and rails must be electrically conductive and may not be painted 
• Screwed connections must be made directly on bare surfaces of the control panel 
• Use flat bonding conductors made of copper or flat meshes 
• Establish ground connections to control panel doors via flat bonding conductors 

made of copper (connection in addition to the normal protective earth, if required) 

When planning the control panel, strong emitters of interference must be separated 
from other devices. Particular care must be taken with the electrical connections 
between these 2 groups of devices. 
Separation of interference emitters and interference-susceptible equipment:  
• Use separate control panels for strong interference emitters and interference-

susceptible equipment 
• If necessary, place strong sources of interference outside the control panel without 

infringing the safety regulations for the relevant devices 
• Use a partition inside the control panel 
To comply with EMC requirements, the following rules must be observed:  
• Run interference-susceptible cables separately, as close as possible to the reference 

ground (metal mounting plate or control panel) 
• Single-point entry: All connections on the same side of the control panel (mains 

power and control cables / inputs and outputs) 
• Cable loops should be avoided 
• Provide sufficient space for the connection of cable shields 
• Integration of the control panel into the building’s equipotential bonding system 
 
Prerequisite for the proper connection of the cable shield is the availability of a 
reference ground. The reference ground is used to divert interference currents that flow 
through the cable shields. 

Example of equipotential 
bonding and surge 
protection at the point of 
entry to the building 

Control panels 
Grounding 

Control panel conforming 
to EMC directives 

Connections conforming  
to EMC directives 

Connecting the  
cable shields 
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20
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4
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1 
2 
3 
4 
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6 
7 
8 

Connection of cable shields with metal clamps 
Shielded sensor cables 
Control cable from the process 
Terminal strip 
Metal baseplate  
unshielded primary cable  
Shielded primary cable 
Connection to equipotential bonding system 
Grounding to the metal box 

 
• The connection of cable shields must be circumferential and be made directly to the 

reference ground, preferably with metal clamping devices, such as cable clamps  
• Pigtails for the connection of cable shields are unsuitable, even if only a few cm long 
• Cable shields must always be properly connected to reference ground and, usually, 

at both ends (housing, control panel)  
 
• Inductive plant components such as industrial relays, contactors, magnetic valves, 

etc., must be fitted with adequate spark quenching using an RC unit which is to be 
connected in parallel to the coil causing the interference 

• An alternative solution which causes practically no interference is the use of solid 
state relays 

• Varistors (zinc oxide resistors) ensure voltage limitations, but do not provide 
adequate spark quenching 

 

2.5.7 Bus power supply 
 

 
 

Plant containing a maximum of 16 devices can be operated without central bus power 
supply. In that case, the bus power supply of each individual controller must be 
switched on (when using a central bus power supply, e.g. via the OCI600, all controller 
bus power supplies must be switched off). 

The LPB devices can be connected to the bus at any point as long as the cable lengths 
and the maximum network extension are observed: 

N1 N3 N4

N5N2

25
29

Z2
6

 
N1...N5 LPB-compatible controllers 

 
Note:  
• The devices’ LPB connections are not galvanically separated 
• The correct polarity of the connections must be observed  
 

Correct mounting of cable 
shields inside conduit 
boxes 

Spark quenching 

Bus power supply  
via controllers 
Introduction 

Connection 
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When using an OCI600 central communication unit, central bus power supply must be 
used. It can be provided by the OCI600 itself, the SYNERGYR OZW30 central unit or 
the PNE power supply unit (refer to Data Sheet N8943). Only 1 central bus power 
supply per system is permitted. 
If Batibus devices are used, central bus power supply is mandatory. 

Only LPB-compatible or Batibus-compatible devices may be used. Note:  
• A maximum of 40 LPB-compatible devices may be connected 
• The ohmic resistance of the cable between the bus power supply and a device must 

not exceed 12 Ω 
• The bus power supply unit should be installed as close as possible to the center of 

the network 
• When using a central bus power supply, the controller bus power supply on the 

devices must be switched off. If this is not observed, overcurrents on the bus can 
occur. Siemens will not assume responsibility for any damage resulting from such 
overcurrents 

• If an OCI600 central communication unit or OZW30 central unit is connected to the 
LPB, one of them can be used to provide the function of central bus power supply. It 
must be ensured that only 1 central bus power supply is activated at a time 
(overcurrents on the LPB) 

All devices connected to the bus – assigned to 2 central units – are parameterized. The 
bus power supply on the OZW30 is switched on; all other bus power supplies 
(controllers and OCI600) must be switched off. 

N1 N3 N4

N5N2

25
29

Z2
2

N6  
N1 Central communication unit OCI600 
N2...N5 LPB-compatible controllers 
N6 Central unit OZW30 with bus power supply switched on  

 
The LPB devices can be connected to the bus at any point of the network, provided the 
cable lengths and the maximum network extension are observed. 
The right polarity of the connections must be observed. 
 

Central bus power supply: 
Central communication unit

Introduction 

Note 

Prerequisites 

Example  

Connection 
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2.5.8 Bus sizing 
 

 

When using a bus power supply via the controllers, the number of devices is limited to 
16, the reason being capacity. 

When using a central bus power supply, the number of devices is limited due to data 
throughput (bus loading). The precise number of devices depends on the types of 
controller used. For more detailed information, refer to paragraph “Bus loading” below. 

The usable transmission capacity of the LPB is about 600 telegrams per minute on 
average. Each device connected to the LPB generates device-specific data traffic. The 
bus loading level corresponding to the amount of data traffic is expressed by the bus 
loading number E. For each device, a bus loading number E can be defined:  

Device telegrams / minute 
E = 

2 
The total of all bus loading numbers E of the connected devices must need exceed 
300. 

The following table contains the presently known bus loading numbers E of the LPB-
compatible devices supplied by Siemens HVP.  

Product line, series Type 
reference 

Bus loading number 

RVL469 6 
RVL470 6 
RVL471 7 

Heating controllers RVL4... 

RVL472 7 
RVP300 6 
RVP310 7 
RVP320 7 

Heating controllers RVP3... 

RVP330 10 
Energy managers RVP5... RVP5... 3 

RVD23... 3 District heating controllers 
RVD2... RVD24... 4 

RVA43.222 3 
RVA43.223 3 
RVA46.531 6 
RVA47.320 3 
RVA63.242 3 
RVA63.280 3 
RVA65... 3 

OEM heating controllers 
RVA... 

RVA66.540 6 
Ventilation controllers 
AEROGYR  

RWI65...  5 

Pulse adapter AEW2.1 <1 
Temperature sensor/adapter QAB30.600 <1 
Input module  DOE4IN <<1 
Relay module  DOE4RE <<1 
Central communication unit OCI600 46 

Number of devices 
Bus power supply  
via controllers  

Central bus  
power supply 

Bus loading 
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• The LPB is a non-exchangeable 2-wire bus 
• The bus cable should be a twisted 2-core cable 
If several individual wires are used, they must be twisted.  

The bus cable is to be connected to terminals MB– and DB+ of the LPB devices. 
Polarity must be strictly observed. 
In the case of T-branches, it is recommended to use a conduit box. 

• Cable extension:  
Maximum cable length between the 2 remotest devices in the entire network. In the 
following example, this is the cable length from N1 to N5 or (l1 + l2 + l5) 

• Total cable length / sum of all branches:  
Sum of all interconnected cable lengths. In the following example, this is the cable 
length (l1 + l2 + l3 + l4 + l5 + l6 + l7 + l8) 

• Maximum power supply distance: 
Cable between the remotest device and the central bus power supply 

N1 N3 N4

N5N2

25
29

Z2
3

1 2

3 4 5

6

7 8

N6  
l1...l8 Cable sections  
N1...N5 LPB-compatible controllers 
N6 Central communication unit OCI600 
  

• Maximum total cable capacitance:  
This is the capacitance the bus cable must not exceed. It varies depending on the 
electrical characteristics of the bus cable: 
Total cable capacitance = total cable length x capacitance per unit length K1 

 

The cross-sectional area required depends on the type of bus power supply. 

If the bus is powered by the controllers, a minimum cross-sectional area of 1.5 mm2 is 
mandatory.  

In case of a central bus power supply, it is also possible to use other cross-sectional 
areas which are listed below together with their related cable lengths.

Cable characteristics 

Connection of bus  
cable 

Types of limitations:  
Terms 

Example 

Types of limitations 

Cross-sectional area 
Bus power supply  
via controllers 

Central bus power  
supply 
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The following 2 tables contain the different permissible maximum cable lengths 
depending on cable resistance and cable capacitance as the physical criteria. The 
resulting lengths are very much dependent on whether a bus power supply via the 
controllers or a central bus power supply is used.  of b 

If the LPB is powered by the controllers, the following maximum cable lengths must be 
observed, based on a cross-sectional area of 1.5 mm2: 

Limitation of cable resistance R: 

Cable extension - 250 m for each connected device 
- Maximum 1,000 m 

Limitation of cable capacitance C: 

Maximum total cable capacitance - 25 nF for each connected device 
- Maximum 140 nF 

Hence, at a cable capacitance of 100 pF/m, 
the total cable length / sum of all branches is: 

- 250 m for each connected device 
- Maximum 1,400 m 

At a cable capacitance other than 100 pF/m, the permissible total cable length must be 
calculated using the following formula: 

l'
l

=
×  100 pF / m

K1
  

Where: 
 
l [m]  Calculated cable length at 100 pF/m 
l’ [m] Maximum cable length at K1 
K1 [pf/m] Effective cable capacitance per unit length 

 
In the case of a central bus power supply, the cross-sectional area can vary. Based on 
the selected type of cable, the following cable lengths are obtained: 

Limitation cable resistance R: 

Cross-sectional area 0.5 mm2 
(0.8 mm Ø) 

0.75 mm2 1.0 mm2 1.5 mm2 2.5 mm2 

Cable extension 320 m 460 m 620 m 920 m 1,200 m 
Max. power supply distance 160 m 230 m 310 m 460 m 600 m 
Limitation cable capacitance C: 

Cross-sectional area 0.5 mm2 
(0.8 mm Ø) 

0.75 mm2 1.0 mm2 1.5 mm2 2.5 mm2 

Total cable length / sum of all 
branches: (At a cable 
capacitance of 100 pF/m) 

2,500 m 2,500 m 2,500 m 2,500 m 2,500 m 

At a cable capacitance other than 100 pF/m, the permissible total cable length must be 
calculated using the following formula: 

l'
l

=
×  100 pF / m

K1
  

Where: 
 
l [m]  Calculated cable length at 100 pF/m 
l’ [m] Maximum cable length at K1 
K1 [pf/m] Effective cable capacitance per unit length 

 
Data Sheet N2032, “Local Process Bus LPB, Basic Engineering Data”, contains 
detailed examples with graphs relating to the figures given in the above tables and the 
types of limitation. 
 

Cable lengths 

Bus power supply  
via controllers  

Central bus power  
supply 
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2.5.9 Technical data of LPB 
 

Physical Layer to 
ISO / OSI 

voltage level and character transmission to NF C 46 621 

Data Link Layer to 
ISO / OSI 

bus access procedure, telegram makeup, transmission and 
data backup to NF C 46 622 

Application Layer to 
ISO / OSI 

Siemens HVP-specific 

Open-circuit bus voltage 15.5 V ± 10 % (with no load)  
Signal level  < 7 V = logic 1 

> 9 V = logic 0 
Cable capacitance ≤ 100 pF/m at 800 Hz 1) 
Bus topology line, tree, star or combinations of them  
Character transmission NRZ coding, 8 data bit, odd parity, 1 stop bit 
Baud rate 4800 Baud 
Telegram length max. 32 characters 
Transmission capacity average of about 10 telegrams per second 
Bus access procedure CSMA/CA (multi-access with collision prevention) 
Number of users max. 16 with bus power supply via controllers 

max. 40 with central bus power supply 2) 
1) Higher values demand a proportional reduction of the permissible total cable length 
2) Depending on the bus loading numbers E of the devices used  

 



38/88 

Building Technologies Central Communication Unit OCI600 CE1P2529en 
HVAC Products 3 Commissioning with the ACS7... 09.01.2006 

3 Commissioning with the ACS7... 
3.1 Introduction 
 

The ACS7... is a software package for parameterizing, monitoring and reading the data 
points (also refer to section 3.2) of the OCI600 central communication unit, its 
peripheral devices and connected controllers. 
Communication between the ACS7... and the OCI600 is opened via an RS-232 port or 
a modem connection (also refer to chapter 4). 
The ACS7… software can establish a connection to several plants via different 
communication interfaces (COM ports), but not simultaneously. 
Operation of the ACS7... software is described in its Online Help which, when the 
software runs, can be accessed via Help > Help. 

3.1.1 Applications of the ACS7... software package 
 

The ACS7... software package contains the following applications: 

Application Brief description 
Popcard… • Visualization and parameterization (online) of all data points 

transmitted by the devices connected to the bus 
• Possibility to create own Popcards 

Parameter 
settings… 

• Visualization and parameterization of the data points and 
setting parameters defined in the device description as a 
standard parameter data set 

• Possibility to store the parameters of a plant offline and to 
reload them later 

Offline trend… • Offline acquisition of the dynamic behavior of selected data 
points of the plant. 
The acquired data are stored on the memory card of the 
OCI600 central communication unit 

• Preparation of data in a graphic window 
• Further handling with a spreadsheet program 

Online trend… • Online acquisition of the dynamic behavior of selected data 
points of the plant 

• Online presentation of data in a graphic window 
• Further handling with a spreadsheet program 

Commissioning 
report… 

• Querying and recording data points and setting values of 
individual devices, device groups or of the entire plant 

File transfer… • Reading data from the OCI600 central communication unit 
and from the memory card of the OCI600 (offline trend files) 

Plant diagram… • Graphic presentation of plant including display of the plant 
values 

The user of the ACS7… can access the various applications, depending on the kind of 
license he has. 
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3.1.2 Device descriptions 
 

The ACS7... software contains a device description of each supported device. The 
device description is thus the link between the applications of the ACS7... software and 
the devices connected to the LPB. The device descriptions are supplied with default 
and limit values of the parameters that can be set. 

3.1.3 Detection of LPB devices 
 

The ACS7... software makes it possible to present the entire system and to access the 
individual devices installed in the plant. 

With the help of the ACS7…, each LPB bus user must be assigned an address in the 
OCI600 device directory. These addresses must accord with the addresses set on the 
devices. 

If the device address of a bus user is changed, the device directory of the OCI600 
central communication unit must be updated. Then, using function Plant > Refresh 
device list, the device with the new address must be uploaded. 

If devices cannot be detected, the reason may be one of the following: 

• The same address was assigned to 2 different devices, which lead to an address 
conflict 

• The device is no longer available or is faulty. After choosing function Plant > 
Refresh device list, such a device appears in red Italics 

For a detailed description of the procedure covering addressing on the software side, 
refer to section “3.3 Integrating the devices”. 
 

Sources of error 
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3.2 Data points of a plant 
 

Similar to a file Explorer, the ACS7... software shows the devices and their associated 
Popcards in the form of a tree structure on the left. The plus symbol is used to let the 
sublevels appear. The sublevels of the Popcards are called operating pages. 

When an operating page is selected, the configuration of this operational unit appears 
in the right window. The configurations always contain the “Data point” column. In the 
ACS7…software, a “Data point” is the variable that can be set and / or read. 

 

The Popcard… and Parameter settings… applications provide additional information 
about the status of data points. When such a data point is selected, “Data point status” 
can be opened with the right mouse button > Status. 

Checking the status  
of a data point 
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Status Description 
Override Data point in overwrite mode. The current value is not valid. The 

value was preselected externally 
Out of service Data point not used by the device application (inactive; out of 

operation) 
Event enable Event messages for the data point are enabled 
Device error Device error with impact on the data point. If no differentiation 

can be made between peripheral error and device error, a 
device error will be displayed 

Periphery error Error of a peripheral device (external sensors, actuating 
devices, cables) with impact on the data point 

Disturbed Alarm status flag; fault has occurred 
Unacknowledged Alarm status flag; alarm unacknowledged 

 
The Popcards show data points that can be written in the form of a solid circle, data 
points that cannot be written in the form of an empty circle. 
Then, the user level is of importance. An administrator can change a number of data 
points that a user cannot access. 

1. Double click on the line with the data point to be changed. 
The Data point command window appears. The look of this window depends on 
the type of data point. 

2. Assign the data point the required value in the “Value” tab. 
3. The “Command” tab holds the following functions: 

Function / button Description 
Write Normal write access. 

Must not normally be performed since after a 
change in the “Value” tab, the value will 
automatically be written to the OCI600 

Default Data point will be set to the standard value 
Change “Out of service” state 
Button raised > button 
recessed 

Deactivates the data point. 
This function is used to deactivate switching points 
in time programs, for example 

Change “Out of service”  
Button recessed > button 
raised 

Activates the data point with the value set in the 
“Value” tab 

 
 

Contents of information 
box “Data point status” 

Changing the values  
of a data point 
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3.3 Integrating the devices 
3.3.1 Integrating the controllers into the OCI600 
 

Each controller must be assigned an individual segment and device number which 
must accord with those in the device directory of the OCI600 central communication 
unit. 

The controllers’ local bus power supply must be switched off. Power will be provided by 
the OCI600 central communication unit. 

It is recommended to define the OCI600 central communication unit as the clock time 
master and the controllers as slaves with or without remote control (refer to chapter 6). 

The procedure with the ACS7... software is the following: 

 
 
1. From the Applications > Popcard… menu, select operating page Device 

directory. For the 16 controllers that can be connected, the right window shows 
you the data points “Device n name”, “Device n device number”, and “Device n 
segment number”. 
Note: In this User Manual, index “n” denotes a consecutive number (here 
controllers 1 through 16). 

2. Double-click on the relevant line to open the entry field for entering the controller’s 
name (maximum 16 characters), the device number and the segment number. 
Both the device number and the segment number must accord with the settings 
made on the controller. 

3. Repeat step 2 above with all the other controllers. 
 

Assigning addresses 

Bus power supply 

Time synchronization 

Settings in the ACS7... 
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3.3.2 Integrating the AEW2.1 pulse adapters into the OCI600 
 

The OCI600 central communication unit supports up to 6 AEW2.1 pulse adapters. They 
have 2 pulse inputs and are used to convert in conformance with LPB requirements the 
consumption values (e.g. water, electricity, gas, etc.) acquired by the consumption meters 
in buildings. To commission the pulse adapters, the AZW30 service unit should be used. 

Before integrating the pulse adapter into the OCI600, ensure that: 
• Power is available 
• The pulse adapter has the address plug fitted 
• The LED on the pulse adapter flashes 

When these preconditions are satisfied, make the settings in the ACS7... operating 
software: 

 

1. On the View menu, deactivate Consider dependencies to also show devices that 
have not been configured. 

2. From the Applications > Popcard… menu, select operating page “Counter module 
n”. Then, the right half of the screen will show data points “Counter module n name” 
and “Counter module n address”. 

3. Double-click on the respective line to open the entry field for entering the counter 
module’s name (maximum 16 characters) and address. The counter module’s 
address must accord with that set on the AEW2.1. 

4. Repeat steps 2 and 3 above with all counter modules. 

 

Brief description 

Preparatory work 

Settings in ACS7... 
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3.3.3 Integrating the QAB30.600 temperature sensor into the 

OCI600 
 

The QAB30.600 temperature sensor / adapter is used to acquire temperatures via 
sensors and to transmit them to the OCI600 central communication unit via LPB. 

The OCI600 supports 2 QAB30.600 temperature sensors / adapters each with 2 inputs.  

An immersion sensor for acquiring the flow temperature, for example, is connected to 
one input. An outside sensor or room temperature sensor (LG-Ni 1000) can be 
connected to the other input. 

For each input, 2 temperature limit values can be defined. An alarm can be triggered 
when the temperature crosses one of these limits. 

T

Tmax = 90°C

Tmin = 85°C

t

25
29

D
01

1°C

1°C

 
Tmax Upper temperature limit value 
Tmin Lower temperature limit value 
T Temperature 
t Time  
Note: The switching differential (hysteresis) is 1°C 

 
 
Before starting to parameterize a temperature sensor, ensure that: 
• Power is supplied to the QAB30.600 temperature sensor 
• The address plug is fitted  
• The LED on the device flashes 

 

Brief description 

Example 

Preparatory work  
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When these preconditions are satisfied, make the required settings in the ACS7... 
operating software: 

 

1. On the View menu, deactivate Consider dependencies. 
2. From the Applications > Popcard… menu, select operating page “Temp module 

n”. Then, the right half of the screen will show you the 2 data points “Temp module 
n name” and “Temp module n address” for each temperature module. 

3. Double-click on the respective line to open the entry field for entering the 
temperature module’s name (maximum 16 characters) and address. The 
temperature module’s address must accord with that set on the QAB30.600. 

4. Likewise, on the lower operating page “Input n”, you can enter data points “Temp 
module n input n name”, “Temp module n input n minimum” and “Temp module n 
input n maximum” for each input. The difference of the limit values must be a 
minimum of 3 °C. 
On line “Temp module n input n measured value”, you can read the current 
temperature. 

5. Repeat steps 2 through 4 above for the second temperature module. 

 

 

Settings in ACS7... 



46/88 

Building Technologies Central Communication Unit OCI600 CE1P2529en 
HVAC Products 3 Commissioning with the ACS7... 09.01.2006 

3.3.4 Integrating the DOE4IN input module into the OCI600 
 

The OCI600 central communication unit supports a maximum of 4 optional digital 
DOE4IN input modules (standard Batibus) each with 4 inputs. 

Before integrating the DOE4IN input module into the OCI600 central communication 
unit, ensure that: 
• Power is available 
• The LED on the input module flashes 

When these preconditions are satisfied, make the required settings in the ACS7...  
software: 

 

1. On the View menu, deactivate Consider dependencies. 
2. From the Applications > Popcard… menu, select operating page “Input module n”. 

Then, the right half of the screen will show you data points “Input module n name”, 
“Input module n device number” and “Input module n segment number” for each 
input module. 

3. Double-click on the respective line to open the entry field for entering the module’s 
name (maximum 16 characters), the device number, and the segment number. Both 
the devices and the segment number must accord with the settings made on the 
Batibus input modules. 

4. Parameterize the 4 inputs of each input module as described in subsection “3.3.6 
Parameterizing the digital inputs of the OCI600”. 

5. Repeat steps 2 to 4 above with all input modules. 

 

Brief description 

Preparatory work 

Settings in ACS7... 
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3.3.5 Integrating the DOE4RE relay module into the OCI600 
 

The OCI600 central communication unit supports a maximum of 4 optional relay 
modules (standard Batibus) each with 4 outputs. 

Before integrating the DOE4RE input module into the OCI600, ensure that: 
• Power is available 
• The LED on the relay module flashes 

When these preconditions are satisfied, make the required settings in the ACS7… 
software: 

 

1. On the View menu, deactivate Consider dependencies. 
2. From the Applications > Popcard… menu, select operating page “Relay module n”. 

Then, the right half of the screen will show you data points “Relay module n name”, 
“Relay module n device number” and “Relay module n segment number” for each 
relay module. 

3. Double-click on the respective line to open the entry field for entering the module’s 
name (maximum 16 characters), the device number and the segment number. Both 
the device and the segment number must accord with the settings made on the 
Batibus relay modules. 

4. Expand to go to the operating pages of the individual relays. For each relay, you will 
find data points “Relay module n relay n name”, “Relay module n relay n state” and 
“Relay module n relay n mode”. Edit the name. 

5. You can change data point “Relay module n relay n state” only if data point “Relay 
module n relay n mode” (see next item) is set to “Manual”. 
Note: “On” means “Contact closed”. 

6. For data point “Relay module n relay n mode”, determine how the output relay shall 
be controlled. The parameter values have the following meaning: 

 

Brief description 

Preparatory work 

Settings in ACS7... 
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Parameter value Description 
Manual The state of the relay can be changed manually via the 

Popcard of the ACS7... operating software 
7-day program 
1, 2 or 3 

The relay’s state is controlled by one of the three 7-day 
programs. For every day, 1 switch-on and 1 switch-off time can 
be defined 

 
The 7-day programs can be entered on the Applications > Popcard… menu, 
operating page “Relay TSP”. 

 

3.3.6 Parameterizing the digital inputs of the OCI600 
 

From the Applications > Popcard… menu, select operating page “Inputs OCI600”. 

 

7-day program 

Procedure 
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The 4 digital inputs of the OCI600 are presented as a module to which a freely 
selectable name with a maximum of 16 characters can be assigned. 
For each of the 4 inputs, edit the relevant values of the data points listed below. 

For each input, a freely selectable name with a maximum of 16 characters can be 
entered. 

Parameter value Description 
Signalisation The status of the input will be displayed, 

e.g. burner on or off 
Operating hours The status of the input will be displayed, and the period of 

time during which this status was active. This makes it 
possible to acquire the number of burner operating hours, for 
example 

Service For service purposes, forwarding all alarms of the OCI600 
will be suppressed if an input switch of the service type is 
operated 

Alarm only coming When activating the input, an alarm will automatically be 
delivered to the associated alarm receiver 

Alarm coming and going The input is used as an alarm input. 
Every signal change "Active > Inactive" , 
or vice versa, at the input causes an alarm to be transmitted 

 
Parameter value Description 
Normal Input is inactive when contact is open (NO) 
Inverted Input is inactive when contact is closed (NC) 
 
Assign the phone numbers for the alarm message to the inputs that are parameterized 
as alarms. Alarm messages can be delivered to 4 different phone numbers in different 
combinations. 

Each digital input can be assigned to 1 of the 2 “OCI600 outputs”.  

Parameter value Description 
No action No forwarding 
OCI600 relay 1 Energizing relay 1 in the OCI600 
OCI600 relay 2 Energizing relay 2 in the OCI600 

 
Data points “OCI600 digital input n state” and “OCI600 digit input n operating hours” are 
read only data points. 
 
 

Data point: 
Input n name 

Data point: 
Input n type 

Data point: 
Input n polarity 

Data point: 
Input n call 

Data point: 
Input n relay 
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3.3.7 Parameterizing the digital outputs of the OCI600 
 

From the Applications > Popcard... menu, select operating page “Outputs OCI600”. 

 

The 2 digital outputs of the OCI600 are presented as a module to which a freely 
selectable name with a maximum of 16 characters can be assigned. 

Also, 1 operating level lower, names with a maximum of 16 characters can be assigned 
to the 2 relays. 

Binary output “Relay n state” can be changed directly by the operator if data point 
“Relay n mode” is set to “Manual”. “Relay n mode” can also be set to “7-day program 1” 
through “7-day program 3”. The procedure is the same as that described in “3.3.5 
Integrating the DOE4RE relay module into the OCI600”. 

The inputs of “Input module 1” through “Input module 4” of “Log. inputs OCI600” and 
“Inputs OCI600” (digital inputs) can be switched to the 2 “Outputs OCI600” (digital 
outputs). 
If the states of several inputs are forwarded to the same relay, the relay will stay active 
until all inputs are inactive. This way, a common alarm can be implemented. 

A relay used in this way cannot simultaneously be controlled manually or by a 7-day 
program. Control via inputs has the highest priority. 
 

Procedure 

Data point:  
Relay n name 

Data points:  
Relay n state and  
Relay n mode 

Linking inputs  
with outputs 

Note 
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3.3.8 Parameterizing the logic inputs 
 

As mentioned in subsections 3.3.4 and 3.3.6, each of the Batibus inputs and the digital 
inputs has data point “Input n type”, which can be used to activate an alarm. In addition, 
the “Logic inputs OCI600” can be used to implement a common alarm for 4 error 
groups. The following 4 error groups are ready assigned to the 4 inputs of the “Logic 
inputs OCI600”: 

Input Meaning 
1: Communication error Internal error of OCI600 (error codes 80-99) 
2: LPB device error Error messages from LPB controllers 1) 
3: Sensor error Error messages from QAB30.600 temperature sensors 
4: SYNERGYR error Error messages from an OZW30 central unit connected 

to the bus 
1) The controller delivers an alarm message via bus only if the priority of the error is high enough 

 
From the Applications > Popcard… menu, select operating page “Log. inputs 
OCI600”. 
The 4 logic inputs at the OCI600 will be presented as a module to which a freely 
selectable name with a maximum of 16 characters can be assigned. 

 
For each of the 4 logic inputs, edit the relevant values of the data points mentioned 
below. 

For each input, a freely selectable name with a maximum of 16 characters can be 
entered. 

Parameter value Description 
Signalisation The status of the logic input will be displayed, e.g. input 1: 

Communication error present or not present 
Operating hours No function 
Service No function 
Alarm only coming An alarm will be delivered when an error from the error 

group of the logic input occurs 
Alarm coming and going An alarm will be delivered when an error from the error 

group of the logic input occurs and disappears 
 
Recommendation: Always set the polarity to “Normal” (the delivery of alarms when no 
alarms occur, or vice versa, makes no sense). 

Alarm function for  
4 error groups 

Procedure 

Data point: 
Logic input n name 

Data point: 
Logic input n type 

Data point: 
Input n polarity 
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For the logic inputs parameterized as alarms, select the phone number to which the 
alarm message shall be sent. Alarm messages can be sent to 4 different numbers in 
different combinations. 

Each logic input can be assigned to 1 of the 2 “Outputs OCI600”. 

3.4 Notes on storing and loading a configuration 
 

Special loading of the edited settings is not required on the Popcards. Once connected, 
the changed values will be directly written to the OCI600 where they are stored. 

Using Applications > Parameter settings… in ACS Operating and ACS Service, the 
configurations of the OCI600 (and of all other devices that can be reached via LPB) can 
be uploaded, stored in the ACS7…, and from there downloaded to the devices. 
Application examples: 
• In case the OCI600 requires a reset to the factory-set default values (e.g. 

communication password forgotten), a backup is required 
• The current parameter settings shall be used for some other plant, similar or identical 

plant 
• Some other parameter settings shall be tested without having to overwrite the former 

settings 
A detailed description of the Applications > Parameter settings… function is given in 
the Online Help of the ACS7… software. 
 

Data point: 
Input n call 

Data point: 
Input n relay 

Making a backup 
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4 Communication 
4.1 Authorization of access 
  

Each connection that is opened, be it directly via the RS-232 port or via modem and the 
public telephone network, is protected by a password. 
A connection can only be opened if the password in the ACS7... operator station and 
that in the OCI600 agree. 
The password (code no.) in the OCI600 central communication unit is set in the ACS7... 
using the Popcard application on operating page “Passwords”, data point “Code no.”.  

To make possible the first connection between the ACS7... software and the OCI600 
central communication unit, the factory setting of this code no. in the OCI600 is “01”. 

 
To change the code no. that serves as a password, proceed as follows: 

1. In ACS Service – [Popcard], select operating page Passwords. 
Note: In that case, you need to have an online connection to the OCI600. 

2. Enter the new numeric password of the OCI600 under “Code no.” (maximum 7 
numeric characters starting with 0, e.g. 07845). 

3. Select Plant > Plant properties… 
4. Choose Continue to go to dialog box Communication. 
5. Enter the new numeric password of the ACS operator station under Code number 

(same as point 2 above) and close with Finish. 
6. The numeric password is changed and active next time a connection is opened. 
 
If the password of the software under Plant properties … is different from the 
password active in the OCI600 and you do not know the latter, there is only one thing 
you can do, namely to reinitialize the central unit (reset). This is made by 
simultaneously pressing buttons  and  on the left and button  on the right 
both before and when the OCI600 power supply is switched on. When doing this, all 
data will be reset to their factory-set default values. This means that setting values that 

Connection password-
protected 

State as supplied 

Procedure for changing 
the password 

Password forgotten 



54/88 

Building Technologies Central Communication Unit OCI600 CE1P2529en 
HVAC Products 4 Communication 09.01.2006 

have already been parameterized will be lost and the password will be set to “01”. 
Hence, the system must be set up again. 

4.2 Direct connection via RS-232 port 
4.2.1 Hardware 
 

For a direct connection from the PC to the OCI600 central communication unit, use a 
commercially available standard null modem or link cable. The illustration below shows 
the wiring inside the standard null modem cable and link cable. 

Standard null modem cable Link cable 
25-pole 9-pole 

25-pole 25-pole 
Female Female 

28
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4.2.2 Opening the direct connection 
 

1. Use the buttons of the OCI600, operating page 3, line number 11, to select 3 (PC 
local with alarm). 

2. Use operating page 3, line number 08, to select 4 (9600 Baud). 
3. In the ACS7… software, choose menu item Plant > Connection on.  

Status window “Connection information” appears, showing the current state of 
opening the communication. When the connection is open, menu item Plant > 
Connection on is not highlighted and Plant > Connection off and the 
“Disconnect” symbol can be selected. Also, the window heading reads [State - 
Connected]. 

 

Pin assignment 

Opening the direct 
communication 
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4.3 Modem connection 
4.3.1 Introduction 
 

The use of modem technology makes it possible to implement remote monitoring and 
remote alerting. 
Receiver and transmitter of remote monitoring and receiver of alarms can be the 
ACS7… software running on a PC with a modem connection facility. In that case, 2 
modems are used: 1 at the central unit and 1 at the PC. 
The receiver of alarms can also be a mobile phone, pager, fax, serial printer or Minitel 
station (France only). In that case, only 1 modem at the central unit is required. 

Compared to a standard analog modem, an ISDN modem does not offer higher 
speeds since the rate of transmission of the central unit is the limiting element. The use 
of a GSM modem looks promising if it is not possible to run a telephone line. 
Contact the telephone provider to obtain information about the available protocols and 
phone nos. / calling nos. to be set for the required functionalities. 

User Manual U2529 gives the calling nos. for individual countries to be set on operating 
page “Phone numbers”. Please note that these numbers can change and new choices 
may be available when new providers appear on the market. 

Subsection “4.3.2 Installing a PC modem” provides information about the installation of 
modems. An overview of the choices available when selecting a certain modem 
technology and protocols is given in subsection “4.3.3 Selecting the modem and the 
provider”. Subsection “4.3.4 Configuring the modem connection” describes the required 
modem settings, and chapter “5 Alarms” gives a description of the settings steps on the 
software side for all alarm choices. 

4.3.2 Installing a PC modem 
 

The procedure to be followed when integrating a PC modem depends on the type of 
modem and the type of operating system. All Windows versions offer support in their 
Online Help. For that purpose, select Start > Help or click on the Desktop and press 
function key F1. Then, in Windows Online Help, search for “Install modem” and follow 
the instructions given. 

 

More information in  
the User Manual 
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4.3.3 Selecting the modem and the provider 
 

If the plant shall be maintained from a remote location via modem and if alarms shall be 
delivered via the telephone network, 2 modems are needed: 1 at the central unit and 1 
at the PC on which the ACS7... software is installed. It is to be noted here that an ISDN 
modem cannot be combined with an analog or GSM modem; it can only communicate 
with an ISDN partner modem. 

We also recommend testing the compatibility of the 2 modems prior to installing them. 
Even when based on the HAYES AT command set, compatibility cannot necessarily be 
guaranteed. 

To reach a mobile phone, pager or fax, a modem at the OCI600 is required. The 
following protocols are used: 

 
For SMS in the case of an analog modem, the Universal Computer Protocol (UCP) or 
the Telocator Alphanumeric Input Protocol (TAP) for SMS can be used. For pager 
messages, TAP is used. 

The OCI600 supports neither the original AT+ Protocol of GSM modems for sending 
SMS nor pager messages. 
For SMS in the case of a GSM modem, the UCP of an analog connection or the TAP 
for SMS of an analog connection can be used. For pager messages, the TAP number 
of an analog connection is used. 

For SMS with an ISDN modem, the UCP or the TAP for SMS is used. For pager 
messages, TAP is used. 

 
• Does the fixed network provider support the transmission of SMS via UCP or TAP 

and / or the transmission of pager information via TAP? 
• What are the phone nos. / calling nos. (service center nos.) to make use of these 

services? 
• Are these phone nos. for analog modems or ISDN modems? 
• Does the GSM provider support the transmission of SMS or pager information via 

UCP/TAP (not AT+)? 
• What are the phone nos. / calling nos. (service center nos.) to make use of these 

services? 
 

Remote maintenance 
with ACS7... 

Tip 

Use of mobile phone, 
pager or fax 

Application Analog and GSM modem ISDN modem 
Alarm to mobile 
phone 

• UCP 
• TAP for SMS 

• UCP 
• TAP for SMS 

Alarm to pager • TAP • TAP 
Alarm to fax • Modem must support “Group 2 fax 

protocol” 
• Fax terminal must be downward-

compatible and support the “Group 3 
fax protocol” 

Not commercially 
available 

Explanations to  
the table 

Questions for the 
provider 
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4.3.4 Configuring the modem connection 
 

Before connecting a modem to the OCI600, a number of settings must be made on 
operating page “Modem”. The default settings cannot be used. 

 

Make the following data point entries: 

Data point Analog / GSM ISDN (recommendation) 
Modem initialisation string 1 AT&FE0Q0V1X4 ATE0Q0V1X4 
Modem initialisation string 2 ATS0=2 ATS0=2 
Modem hangup string ATH0 ATH 
Modem dial string ATDT ATD 

In addition, the ISDN adapter requires the following presettings (recommendation), 
which must be made with a terminal program (e.g. Windows Hyper Terminal) before 
connecting the modem to the central unit: 

 
 

Procedure 
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4.3.5 Notes on communication choices 
 

The type of communication of the OCI600 can be selected with its buttons, using 
operating page 3, line number 11: 

Type of 
communication 

Description, notes on alarm behavior  

0 = Minitel local (As supplied); can only be used in France 
1 = Modem • The OCI600 is operated from a PC with ACS7... via the 

telephone network 
• The alarm message is sent to the selected alarm receiver 

(refer to chapter “5 Alarms”) 
• Note: Once a PC with ACS Operating has opened a 

connection to the OCI600, the latter cannot send any alarms 
during that time, because the connection is busy (general 
system characteristic of a telephone connection) 

2 = PC local without 
alarms 

Alarm messages are not delivered during the time a 
connection is opened 

3 = PC local with 
alarms 

Alarm messages are also delivered during the time a 
connection is opened  

Especially in the case of communication via modem (fax, pager, mobile phone), the 
provider may send the message at a low Baud rate (e.g. 1200 Baud). The only rule to 
be observed by the user of the OCI600 is to ensure that the Baud rate set on the 
OCI600 is not lower than that set on the telephone network. For that reason, the 
maximum Baud rate is to be set to 9600 Baud. 

The Baud rate of the OCI600 central communication unit is to be set with its buttons on 
operating page 3, line number 8. For both the direct connection and communication via 
modem, the setting to be used is 4 = 9600 Baud. 

4.3.6 Opening the connection via modem 
 

1. Cut the direct connection between PC and OCI600, if such a connection exists. 
2. Connect the modem to the OCI600 and check power supply and the cables to the 

OCI600 and those to the telephone network. 
3. On the OCI600, line number 11 of operating page 3, set the parameter: 

1 = modem. 
4. Connect the second modem to the PC and check power supply and the cables to the 

communication network and those to the COM port. 
5. Start ACS Operating. 

Note: Communication via modem can only be opened with ACS Operating. 
6. Choose menu Plant > Plant properties… 
7. Choose Continue > to go to the “Communication” dialog. 
8. At “Connection:”, select your modem on the PC side. 
9. In field “Phone no. plant:”, enter the phone no. of the modem on the OCI600 side. 
10. Close the dialog by selecting “Finish”. 
11. Choose menu item Plant > Connection on. 
12. Status window “Connection information” appears showing the current state of the 

communication opening process. Once the connection is established, menu item 
Plant > Connection on is not highlighted, and Plant > Connection off and the 
“Disconnect” symbol can be selected. In addition, the window heading reads [State 
- Connected]. 

Selecting the type  
of communication 

General information 
about Baud rate 

Procedure 

Note on ACS  
operation 
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5 Alarms 
5.1 Alarms and errors with the OCI600 
 

Alarms are triggered by the alarm-capable inputs of the OCI600, which are: 
• The Batibus inputs DOE4IN 
• The digital inputs of the OCI600 
• The logic inputs of the OCI600 

Errors are internal malfunctions of the OCI600, communication errors and malfunctions 
of LPB users forwarded via the LPB. For more information about errors and the entire 
list of errors, refer to chapter “7 Error handling”. 

The 4 logic inputs make it possible to further handle part of the potential errors as 
alarms. For more detailed information, also refer to subsection “3.3.8 Parameterizing 
the logic inputs”. 

When the ACS7… software is installed on a PC, ACS Alarm can be employed for 
convenient alarm handling. In the event of an alarm, the OCI600 calls the PC modem 
or contacts the directly connected PC, where ACS Alarm visualizes the event. The 
OCI600 can send an SMS, pager message or fax to the mobile service engineer. In 
France, the OCI600 can also call a Minitel station. 

5.2 System report 
 

The system report can be used to transmit regular reports about the plant’s state, 
enabling the plant or plant section to be checked at regular intervals. The system report 
shows primarily pending – not yet acknowledged – plant alarms, but also counter 
values and the number of operating hours. The digital inputs and counters must be 
appropriately parameterized. 
The reporting cycle can be set to 1...99 days. 

The parameters of the system report are to be set in the Popcard… application on 
operating page System report.  

 

Terms:  
Alarms and errors 

Alarm handling 

Parameter settings 
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Parameter value Description 
System report reporting 
time 

This is the time of day the system report is sent to the 
assigned phone no. 

System report reporting 
cycle 

1...99 days  

System report call The receivers of the system report can be entered: 
• In the case of direct communication, a system report is 

sent to the PC with ACS Alarm for each phone no. set 
• In the case of communication via the telephone 

network, the system report can be transmitted to a PC, 
fax or, in France, Minitel station. The relevant settings 
are to be made on operating page “Phone numbers.” 
(refer to the next subsections) 

System report operating 
hours / counter values 

If “Yes” has been entered, the system report also 
includes counter values and the number of operating 
hours 

  
When a system report is sent to a pager, or via SMS to a mobile phone, only the 
sender and the plant’s name appear on the display, but no data. These restrictions are 
to be observed since the system report is too large for the transmission to mobile 
phones and pagers. 
 

System report: Mobile 
phone and pager 
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5.3 Sending alarms to the directly connected 
ACS7... software 

 

1. On the OCI600, on line number 11 of operating page 3, select:  
3 = PC local with alarms. 

2. On line number 08 of operating page 3, select: 
4 = 9600 Baud. 

3. Establish the cable connection between PC and central unit. 

4. Start ACS Alarm via the ACS Alarm icon on your Desktop or via Start > 
Programs > ACS > ACS Alarm. 

5. Open the Extras > Connections… menu. 
6. Select the line with the PC port to which the cable is connected (e.g. COM1) and 

double-click on the respective line in the “Driver” column. 
7. Select the type of central unit “OCI600” and close by choosing “Supervise” and 

“OK”. 

 

5.3.1 Testing the alarms 
 

It is recommended to test the alarms as long as there is a local connection to the plant. 
If communication takes place via modem, it is more difficult to rectify parameter setting 
errors. The easiest way to make an alarm test is to trigger a system report. 
 
The only obstacle is that system reports can only be received once a day. For this 
reason – in the procedure described below – the system time is put forward one day. 
 
You are still using the ACS Alarm software. 
1. Choose Window > New system report window. 
2. Start ACS Service and open Applications > Popcard… 
3. On operating page Miscellaneous, set data point “Time of day” to the date of the 

previous day and wait about 1 minute. 
4. On operating page System report, keep data point “System report reporting time” 

and edit the following data points: 
“System report reporting cycle”: 1 
“System report call”: E.g. phone number 1+2+3+4 
“System report operating hours / counter values”: Yes 

5. On operating line Miscellaneous, set the time of day back to the correct date. 
Within 3 minutes, ACS Alarm should produce 4 system reports for the 4 phone 
numbers. 

Procedure 
 

Triggering a  
system report 

Note 

Procedure 
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In contrast to the alarm functions via the telephone network, which are covered by the 
following subsections, operating page “Phone numbers.” for direct mode need not be 
configured. 

However, to ensure that an alarm or system report can be delivered, at least one phone 
no. must be selected at data point “Input n call” (for alarms) and at data point “System 
report call” (for system reports). If more than 1 phone number is selected, an alarm 
message or system report will be transmitted to ACS Alarm for each number (also refer 
to the example given in the last subsection). 

5.4 Alarms by ACS7… connected via modem 
 

1. On the OCI600, line number 11 of operating page 3, select: 1 = modem 
2. On line number 8 of operating page 3, select: 4 = 9600 Baud. 
3. Establish the hardware connection according to subsection “4.3.6 Opening the 

connection”. 
4. Start ACS Alarm via the ACS Alarm icon on your Desktop or via Start > 

Programs > ACS > ACS Alarm. 
5. Open menu Tools > Connections… 
6. Select the line with your modem entry. 
7. Select the type of central unit “OCI600” and close with “Supervise” and then with 

“OK”. 

In ACS Operating – [Popcard], make the following entries on operating page “Phone 
numbers”: 

Data point Setting 
Phone number OCI600 (Entry optional) 

Plant phone no. OCI600 is transmitted along 
with the alarm text 

Phone number n Phone no. of modem on the PC side 
Additional number for mobile phone 
or pager n 

No entry 

Type of alarm receiver under phone 
number n 

PC alarm receiver 

Modem partner initialisation string n No entry permitted 

You can also test the alarms now, as described in subsection “5.3.1 Testing the 
alarms”. However, in contrast to direct mode, please note that in this case, you need to 
enable the line again (refer to subsection “4.3.5 Notes on communication choices”). 

 

General note:  
Phone numbers / 
direct mode 

Procedure 
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5.5 Alarms to mobile phone 
 

 
In ACS Service – [Popcard], make the following entries on operating page “Phone 
numbers”: 

Data point Setting 
Phone number OCI600 (Entry optional) 

Plant phone no. OCI600; 
displayed together with the SMS 1) 

Phone number n Phone no. of SMS provider 2) 
Additional number for 
mobile phone or pager 
n 

No. of SMS receiver (mobile phone) that shall receive the 
message 2) 

Type of alarm receiver 
under phone number n 

• Mobile phone SMS (UCP) 
• Pager alphanumeric 40 characters (8N1) (TAP for SMS)3) 
• Pager alphanumeric 40 characters (7E1) (TAP for SMS) 3) 
• Pager alphanumeric 80 characters (8N1) (TAP for SMS) 3) 
• Pager alphanumeric 80 characters (7E1) (TAP for SMS) 3) 

Modem partner 
initialisation string n 

No entry permitted 

1) Permitted characters are a-z A-Z 0-9 blanks ! „ # $ % & ‚ ( ) * + ` - . / : ; < = > ? @. 
2) Only numerals permitted, no “+” characters 
3) TAP for SMS: The setting must be made in accordance with the technical outfit of the SMS receiver and the 
extra specification on the phone nos. of the selected TAP for SMS delivered by the provider. The OCI600 limits 
the maximum number of characters to 80 however. Hence, in the case of an SMS receiver providing 160 
characters and the provider specification “00491712092522, 8N1, 160”, the setting to be made is “Pager 
alphanumeric 80 characters (8N1)” 

 

 

Procedure 
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5.6 Alarms to pager 
 

 
In ACS Service – [Popcard], make the following entries on operating page “Phone 
numbers”: 

Data point Setting 
Phone number OCI600 (Entry optional) 

Plant phone no. OCI600; displayed on alphanumeric and 
numeric pagers 1) 

Phone number n Phone no. of pager provider (TAP) for analog / GSM and 
ISDN modem 2) 

Additional number for 
mobile phone or pager n 

Number of pager receiver that shall receive the message 2)

Type of alarm receiver 
under phone number n 

• Pager numeric (8N1) 3) 
• Pager numeric (7E1) 3) 
• Pager alphanumeric 40 characters (8N1) 3) 
• Pager alphanumeric 40 characters (7E1) 3) 
• Pager alphanumeric 80 characters (8N1) 3) 
• Pager alphanumeric 80 characters (7E1) 3) 

Modem partner 
initialisation string n 

No entry permitted 

1)  
• Numeric pager: Only numerals permitted 
• Alphanumeric pager: Permitted characters are: a-z A-Z 0-9 blanks ! „ # $ % & ‚ ( ) * + ` - . / : ; < = > ? 

@. 
2) Only numerals permitted; no “+” characters 
3) The setting must be made in accordance with the technical outfit of the pager and the extra specification on 
the phone nos. of the selected TAP pager delivered by the provider. The OCI600 limits the maximum number 
of characters to 80 however. Hence, in the case of a pager providing 160 characters and the provider 
specification “00491712092522, 8N1, 160”, the setting to be made is “Pager alphanumeric 80 characters 
(8N1)” 

 

 

Procedure 
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5.7 Alarms to fax machine 
 

In ACS Service – [Popcard], make the following entries on operating page “Phone 
numbers”: 

Parameter Setting 
Phone number OCI600 (Entry optional) 

Plant phone no. OCI600; appears on fax 
Phone number n Phone no. of fax machine 1) 
Additional number for 
mobile phone or pager n 

No entry 

Type of alarm receiver 
under phone number n 

Fax 

Modem partner initialisation 
string n 

No entry permitted 

1) Entry must consist of numerals only; no “+” characters permitted 

 

5.8 Waiting times in connection with alarms 
 

In the event of an alarm, the OCI600 central communication unit tries to open a 
connection to the alarm receiver and to deliver an alarm message. If this proves 
impossible at this point in time, the OCI600 will try 2 more times to open the connection 
after a certain waiting time has elapsed. This waiting time depends on the type of 
communication. The time frame within which an alarm is delivered to the respective 
phone no. is predefined and independent of the point in time the alarm-triggering event 
occurred. 
• In the case of a direct connection, the waiting time is 30 seconds. This means that 

it may take 30 seconds for an alarm to be delivered 
• In the case of communication via modem, the waiting time is 10 minutes per 

phone no. An alarm is forwarded to the next phone no. after 2.5 minutes. Hence, 
since 4 phone nos. are available, an attempt is made every 10 minutes to deliver an 
alarm to the same phone no.  

 
A call priority cannot be assigned to phone nos. 1 through 4. For this reason, it is not 
possible to define the phone no. to which the alarm is delivered first. 
 
 

T1 T2 T3 T4 T1T4

10 min

2,5 min

25
29

D
02Alarm

 

T1 Phone no. 1 
T2 Phone no.  2 
T3 Phone no.  3 
T4 Phone no.  4 

 
An alarm shall be delivered to phone no. T1. An alarm can occur at any time. In our 
example, the alarm is delivered to phone no. T1 after about 7 minutes. This means that 
10 minutes is the maximum time from the moment the alarm occurs to the moment it is 
sent to the alarm receiver. 
 

Procedure 

Repetition of  
alarms 

Order of delivering 
alarms 

Example of modem 
communication 
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5.9 Alarm text 
5.9.1 Text with ACS Alarm 
 

In ACS Alarm, the texts of system reports and alarm messages are made up of readily 
available modules of a text database available in the software and the names of the 
reporting input modules as defined by the user, and their inputs. The fixed text modules 
are available in several languages and filed in the database. They appear in the 
language selected when starting up ACS Alarm. 

5.9.2 Text with fax, Minitel and serial pinter 
 

When output on a fax, Minitel or serial printer, the texts of system reports and alarm 
messages consist of the alarm texts as defined by the user and the names of the 
reporting input modules and their inputs. 

The alarm texts are to be parameterized in the Popcard application on operating page 
Alarm texts. 

 

ACS Alarm 

Fax, Minitel and  
serial printer 

Entering alarm text 
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The following example shows a system report as output by a fax machine. In this 
example, the OCI600 has an input whose operating hours are acquired and a counter 
input that is monitored. 

01-03-2005   09:33 
Demo plant   0041 777 5555 
Plant operating state   System report 
No alarms 
Operating hours   Section 
01-03   09:33   General alarms 
Burner 2   On   115  H 
Counter values   Section 
01-03   09:33   Module 1 
Line 1   86   m3x100 
--- End --- 

 
The following layout shows the general makeup of a system report as a fax. When a 
text module begins with “Text for…”, the output shows the text that the user previously 
entered on operating page “Alarm texts”. 
When the line numbers (Z.) are identical, the lines show alternatives. If an alternative 
requires several lines, the numbering is a, b, c, etc. 

L. Text modules 
1 [Date] + [Time of day] 
2 [Name of plant] + [Phone no. of plant] 
3 [Text for system report (Part 1)] + [Text for system report (Part 2)] 
4 [Text for installation alarms (Part 1)] + [Text for installation alarms (Part 2)] 
4 [Text for no installation alarms] 
5 [Text for operating hours (Part 1)] + [Text for operating hours (Part 2)] 
6 [Text for no operating hours (Part 1)] + [Text for no operating hours (Part 2)] 
6a [Date] + [Time of day] + [Module name of inputs] 
6b [Name of input] + [Text for signal state 'On']1) + [Number] + [Hours] 
7 [Text for counter values (Part 1)] + [Text for counter values (Part 1)] 
8 [Text for no counter values] 
8a [Date] + [Time of day] + [Module name of inputs] 
8b [Name of input] + [Number] + [Unit with factor] 
9 [Text for end of message] 
1) Gives the signal state at the time the report is delivered 

The following example shows the presentation of an alarm message delivered by a 
digital input as a fax. 
 
01-03-2005   09:33 
Demo plant   0041 777 5555 
Plant alarms   Section 
01-03   09:33   General alarms 
Dig. input 1   A3   Alarm!   D5   T1 
--- End --- 

Example of a  
system report 

Layout: System report 

Example of alarm 
message: Digital input 
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The following 2 layouts show the makeup of an alarm message of a reporting input and 
of an alarm message of a reporting temperature input as a fax. When a text module 
begins with “Text for…”, the output shows the text that the user previously entered on 
operating page “Alarm texts”. 
When the line numbers (Z.) are identical, the lines show alternatives.  

L. Text modules 
1 [Date] + [Time of day] 
2 [Name of plant] + [Phone no. of plant] 
3 [Text for installation alarms (Part 1)] + [Text for installation alarms (Part 2)] 
4 [Date] + [Time of day] + [Module name of inputs] 
5 [Name report. input] + [Ax] + [Text for alarm state 'Alarm'] + [Dx] + [Tx] 
5 [Name report. input] + [Ax] + [Text for alarm state 'Normal'] + [Dx] + [Tx] 
6 [Text for end of message] 

 
L. Text modules 
1 [Date] + [Time of day] 
2 [Name of plant] + [Phone no. of plant] 
3 [Text for installation alarms (Part 1)] + [Text for installation alarms (Part 2)] 
4 [Date] + [Time of day] + [Temperature module name] 
5 [Name report. temperature input] + [Ax] + [Text for QAB alarm < min] + [Dx] [Tx]
5 [Name report. temperature input] + [Ax] + [Text for alarm state 'Normal'] + [Dx] 

[Tx] 
5 [Name report. temperature input] + [Ax] + [Text for QAB alarm > max] + [Dx] 

[Tx] 
6 [Text for end of message] 

 
In addition, the alarm messages use an alphanumeric code consisting of 2 characters, 
which have the following meaning: 

Parameter settings of alarm type: 
A3 Alarm only coming 
A4 Alarm coming and going 

Parameter settings of alarm calls: 
D1 Phone no. 1 
D2 Phone no. 2 
D3 Phone no. 3 
D4 Phone no. 4 
D5 Phone nos. 1+2 
D6 Phone nos. 1+2+3 
D7 Phone nos. 1+2+3+4 
D8 Phone nos. 3+4 

Identification of phone no. to which the message was just delivered: 
T1 Phone no. 1 
T2 Phone no. 2 
T3 Phone no. 3 
T4 Phone no. 4 
 

Layout alarm  
message: Input 

Layout alarm  
message: Input 
temperature module 

Ax 

Dx 

Tx 
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5.9.3 Text with mobile phone and pager 
 

In the case of a numeric pager and a parameterized alarm input 15, numeric characters 
are sent. This is the phone no. of the OCI600. If this number comprises more than 15 
numerals, the last 15 will be sent. The number must not contain “+” or “/” characters. 

In the case of an alphanumeric pager and SMS and a parameterized alarm input, the 
date, time of day, name of the OCI600, phone no. of the OCI600, name of the reporting 
module and name of the reporting input with a suffix for alarm (AL) or normal (NO) will 
be sent.  

It was mentioned in sections “5.5 Alarms to mobile phone” and “5.6 Alarms to pager” 
that the “Phone no. OCI600” may only contain characters because it is sent along with 
SMS or the alphanumeric pager text. Same must be observed in connection with the 
name of the OCI600, name of the reporting module and name of the reporting input, 
because they are or can be part of the message sent. Here too, the characters 
permitted are: a-z A-Z 0-9 blanks ! „ # $ % & ‚ ( ) * + ` - . / : ; < = > ? @. 

5.10 Alarm programs 
5.10.1 7-day program 
 

The alarm 7-day program is used to activate or deactivate the individual phone nos. in 
a weekly cycle. The program can be specified on the Applications > Popcard… menu, 
operating page “Alarm program”. 

 
For each phone no., enter the period of time per day during which the number shall be 
activated.

Numeric pager 

Alphanumeric pager  
and mobile phone 

Operating page: 
Alarm program 
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Configuration with 4 alarm receivers: 

Phone number Alarm receiver 7-day programming 
1 Service engineer 1: Mobile 

phone 
Always switched on, except on 
Saturdays and Sundays 

2 Service engineer 2: Mobile 
phone 

Always switched on, except on 
Mondays and Tuesdays 

3 Control station: Mobile 
phone 

Always switched on 

4 PC alarm receiver in the 
central control station 

Always switched on 

The unit is supplied with all phone nos. activated during the whole week. 

5.10.2 Holiday program 
 

The “Alarm holiday period” function is used to enter holiday periods. During a holiday 
period, forwarding alarms to the individual phone nos. can be suppressed. The program 
can be defined on the Applications > Popcard … menu, operating page “Alarm 
holiday period”. 

 
 

You find data points for up to 8 programmable holiday periods and a data point 
“Activation”. Using the latter, you can enable all programmed periods for 1 of the 4 
receiver addresses. 

One application would be to acquire all holiday periods at the beginning of the year and 
accommodate them in the 8 periods. When starting the holidays, the relevant receiver 
would have to be activated. 

 

Example 

As supplied 

Operating page: 
Alarm holiday period 

Application example 
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6 Clock time function 
6.1 Synchronization of time of day 
  

The purpose of clock time synchronization is to ensure efficient administration of the 
clock times of LPB devices. Furthermore, it is made certain that incoming alarm 
messages will carry a consistent time stamp. 

To ensure that, within a system of LPB devices, the clock times are identical, one of the 
devices must be defined as the clock time master. 
Clock time master can be a central communication unit (e.g. the OCI600), a controller 
or an AUF77 radio clock receiver. 

Only one of the devices in an LPB system can be the clock time master, or else, an 
error message will be delivered. It is recommended to define the OCI600 central 
communication unit as the clock time master. This can be entered via data point “Clock 
time source” which, with the OCI600, can be found on operating page “Miscellaneous” 
and, with controllers, on operating page “HW Configuration” (RVD240), for example. 

6.2 Setting choices with data point “Clock time 
source” 

 

With each LPB device providing the clock time function, there are 4 choices for the 
value of data point “Clock time source”: 

Value of data point  
“Clock time source” 

Result: 
Date / time of day of this device… 

Autonomous clock ...cannot be influenced by the time-of-day of other 
devices on the LPB. 

From bus: slave without 
remote setting 

…is delivered by the clock time master via LPB. 

From bus: slave with remote 
setting 

…is delivered by the clock time master. If data / time-
of-day of this device is directly changed, the clock time 
master will adopt the adjustment and distribute it to all 
slaves. 

Clock time master …is the master time. 
 

6.3 Clock time master 
 

If the system uses an AUF77 clock time receiver, it automatically becomes the clock 
time master. In that case, the OCI600 central communication unit and the other devices 
used by the system are to be parameterized as slaves with or without remote setting. 

Each device with clock time master function connected to the bus can be 
parameterized as the clock time master. In that case, the other devices used by the 
system are to be parameterized as slaves with or without remote setting. 
 

Radio clock receiver 

Without radio  
clock receiver 
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7 Error handling 
7.1 Error messages 
 

• The OCI600 is integrated in the error signaling system of the LPB system 
• Its display only shows 1 error at a time 
• First, own errors in the order of priority are displayed 
• When own errors are no longer present, the system error with the highest priority will 

be displayed 

An error message consists of a defined error code with a predefined specific error 
priority. 

The error priorities control the orderly forwarding of errors, but are not visible and 
cannot be changed. 
To keep bus loading low, only the error message with the highest priority per segment 
is delivered (that is a maximum of 15 errors in the entire system). If a segment contains 
several controllers, they withhold their error messages with lower priorities until the 
error with the higher priority is rectified. 

Line number 50 of operating page 1 of the OCI600 shows the following display: 
141----1----05 
This reads as follows: 
Device 05 in segment 1 shows its faulty behavior with error code 141. 

Error messages cannot be reset. They are deleted when the relevant error has been 
rectified or temporarily recede into the background if a new error with a higher priority 
occurs. Power failures have no impact on the display of errors. An error that existed 
before the power failure occurred is reported again when power returns. 

7.2 Error codes 
 

The following list shows the meaning of the error codes. 
Error codes 1...149 are identical for all controllers reporting in the LPB system. From 
error code 150, the code may differ from one controller to another. 

Components of an  
error message 

Error priority 

Example of a  
displayed error 

About error  
messages 
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Display Meaning 
10-79 Sensor errors 
10-19 Outdoor sensors 
10 Outside temperature, sensor error 
11 Solar sensor, error 
12 Wind sensor, error 
20-29 Boiler sensors and sensors located close to the boiler 
20 Boiler temperature 1, sensor error 
22 Boiler temperature 2, sensor error 
25 Boiler temperature, wood, sensor error 
26 Common flow temperature, sensor error 
28 Flue gas temperature, sensor error 
30-39 Flow sensors and other sensors 
30 Flow temperature 1, sensor error 
32 Flow temperature 2, sensor error 
33 Flow temperature, heat pump, sensor error 
34 Condenser sensor, heat pump, error 
35 Source inlet temperature, sensor error 
36 Hot-gas temperature compressor 1, sensor error 
37 Hot-gas temperature compressor 2, sensor error 
40-49 Return sensors and other sensors 
40 Return temperature 1, sensor error 
42 Return temperature 2, sensor error 
43 Return temperature, wood, sensor error 
44 Return temperature, heat pump, sensor error 
45 Source outlet temperature, sensor error 
46 Cascade return temperature, sensor error 
47 Common return temperature, sensor error 
48 Refrigerant temperature, liquid, sensor error 
50-59 DHW sensors 
50 DHW temperature / thermostat 1, error  
52 DHW temperature / thermostat 2, error  
54 DHW flow temperature, sensor error 
55 Storage tank 2, DHW temperature / thermostat 1, error 
56 Storage tank 2, DHW temperature / thermostat 2, error 
57 DHW circulation sensor, error 
58 DHW thermostat, error 
60-69 Room sensors, room unit 
60 Room temperature 1, sensor error 
61 Room unit 1, error  
62 Wrong room unit 1 / wrong radio clock module 
64 Room unit 1 (PPS), open-circuit 
65 Room temperature 2, sensor error 
66 Room unit 2, error 
67 Room unit 2, wrong type 
68 Room temperature 3, sensor error 
69 Room unit 2 (PPS), open-circuit 
70-79 Various special sensors 
70 Storage tank temperature 1 (top), sensor error 
71 Storage tank temperature 2 (bottom), sensor error 
72 Storage tank temperature 3 (middle), sensor error 
73 Collector temperature 1, sensor error 
74 Collector temperature 2, sensor error 
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Display Meaning 
75 Bypass temperature, sensor error 
76 Special sensor 1, error 
77 Air pressure, sensor error 
78 Water pressure, sensor error 
79 Brine temperature, sensor error 
80-89 Communication errors 
80 LPB, no communication 
81 LPB short-circuit or no bus power supply 
82 LPB, address collision 
83 BSB wire, short-circuit 
84 BSB wire, address collision 
85 BSB radio communication error 
86 PPS, short-circuit 
87 PPS 2, short-circuit 
88 PPS, no communication 
89 Modem, no communication 
90-99 Device errors 
90 Data loss in RAM 
91 Data loss in EEPROM 
92 Electronics error in device 
93 Change battery 
94 Change battery of memory card 
95 Time of day invalid 
98 Extension module 1, error 
99 Extension module 2, error 
100-105 System errors / miscellaneous 
100 2 clock time masters 
101 Clock time source, wrong setting 
102 Clock time master without power reserve 
105 Maintenance alarm 
106-139 Process errors 
106 Source temperature too low 
107 Error hot-gas compressor 1 
108 Error hot-gas compressor 2 
109 Boiler temperature supervision, error 
110 Safety limit thermostat (SLT), lockout 
111 Thermal reset limit thermostat, safety shutdown 
112 Flue gas SLT, lockout 
113 Flue gas supervision, safety shutdown 
114 Flue gas thermostat has cut out 
115 Flue gas sensor has responded 
116 Flue gas sensor has shut down 
117 Water pressure too high 
118 Water pressure too low 
119 Water pressure switch has cut out 
120 Flow temperature precontrol not reached 
121 Flow temperature heating circuit 1 not reached 
122 Flow temperature heating circuit 2 not reached 
123 Flow temperature DHW not reached 
124 Boiler temperature not reached 
125 Maximum boiler temperature exceeded 
126 DHW charging temperature not reached 
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Display Meaning 
127 Legionella temperature not reached 
128 Loss of flame in operation 
129 Wrong air supply 
130 Flue gas temperature limit exceeded 
131 Burner error 
132 Gas pressure switch safety shutdown 
133 Safety time for establishment of flame exceeded 
134 Common error heat pump 
135 Brine circuit, error 
136 Refrigeration circuit heat pump pressure, error 
137 Operation checkback signal heat pump missing 
138 Control sensor heat pump missing 
140-149 Configuration errors 
140 LPB, address invalid 
141 LPB, configuration not consistent 
142 Partner unit on LPB missing 
145 PPS device, wrong type 
146 Sensor / actuator configuration error 
147 No BMU connected 
148 Incompatibility LPB interface / basic unit 
149 Freely programmable function, configuration error 
150-199 Various device-specific errors 
150 General BMU error 
151 Internal BMU error 
152 Parameter setting error 
153 Device has locked out 
154 Plausibility criterion violated 
155 Remote reset locked 
160-179 External components 
160 Fan speed threshold not reached 
161 Maximum fan speed exceeded 
162 Refer to User Manual of the device causing the error 
163 Modulation valve, error 
164 Flow / pressure switch heating circuit, error 
165 Priority changeover does not work 
166 Air pressure switch does not open 
167 Heating output limits violated 
168 Communication timeout with control of burner 
171 Alarm contact 1 active 
172 Alarm contact 2 active 
173 Alarm contact 3 active 
174 Alarm contact 4 active 
175 Error output freely programmable function active 
176 Water pressure 2 too high 
177 Water pressure 2 too low 
180-199 Special functions are active, various errors 
180 Refer to User Manual of the device causing the error 
181 Refer to User Manual of the device causing the error 
182 Refer to User Manual of the device causing the error 
183 Refer to User Manual of the device causing the error 
184 Refer to User Manual of the device causing the error 
185 Refer to User Manual of the device causing the error 
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Display Meaning 
190 Refer to User Manual of the device causing the error 
191 Refer to User Manual of the device causing the error 
192 Refer to User Manual of the device causing the error 
200-221 Error messages "Non-ALBATROS devices" 
200 Fire / smoke alarm 
201 Frost alarm 
202 Supply air temperature, sensor error 
203 Flow error 
204 Fan error (overload) 
205 Pump / electrical error (overload) 
206 Chiller error (overload) 
210 SYNERGYR, error message 
211 Wood-fired boiler, error 
220 Alarm AUX1 
221 Alarm AUX2 
222 High-pressure with heat pump operation 
223 High-pressure when starting heating circuit 
224 High-pressure when starting DHW charging 
225 Low-pressure 
226 Winding protection compressor 1 
227 Winding protection compressor 2 
228 Flow switch heat source 
229 Pressure switch heat source 
230 Thermal relay source pump 
231-239 Sensor errors of “sensors without special functions” 
231 B101 sensor error 
232 B102 sensor error 
233 B103 sensor error 
234 B104 sensor error 
235 B105 sensor error 
236 B106 sensor error 
237 B107 sensor error 
238 B108 sensor error 
239 B109 sensor error 
241 Flow sensor for yield measurement, error 
242 Return sensor for yield measurement, error 
243 Swimming pool sensor, error 
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7.3 Fault tracing on LPB 
7.3.1 General remarks 
 

Careful planning of LPB engineering, which takes into account a number of parameters, 
such as cross-sectional area, total cable length, distance to the next power source, 
distance between 2 LPB partners, as described in detail in sections 2.4 and 2.5, is the 
best approach to ensure that bus problems will be avoided. Nevertheless, should 
problems occur, the following list provides information on rectification based on 
experience. 

7.3.2 Selected phenomena and proposals for remedy 
 

After a bus settling time of 3 seconds, there is no power on the bus. 
Possible causes: 
• There is no central bus power supply, or it is incorrectly connected 
• The central bus power supply is defective 
• There is a short-circuit on the bus line between bus power supply and measuring 

point 
• The bus line is interrupted 
Remedy: 
Test the bus line for continuity and check the connection. 

The bus voltage (bus level) throughout the network is below 9.5 V (make measurement 
when there is no communication on the bus). 
Possible causes: 
• The bus power supply is not sufficient 
• There is a short-circuit (in that case, the current is about 300 mA) 
Remedy: 
Check or remove: 
• Cable faults 
• Defective devices 
• Sizing of bus power supply 

The devices do not communicate. 
Possible causes: 
1. The cable’s cross-sectional area is too small or the device’s connecting cable too 

long. 
2. The devices have no bus address. 
3. The devices are not connected or are defective. 
Remedy: 
1. Check the Ohmic resistance of the devices’ connecting cables or check bus sizing. 
2. Assign a valid bus address. 
3. Check the devices’ connections. 

The OCI600 displays error code “141” (LPB configuration not consistent). 
Possible causes: 
• It may take up to 12 minutes for the OCI600 to include the devices in the device 

directory 
• The address of at least 1 connected device is not correctly set 
• The device directory does not, or not fully, show the existing plant 
Remedy: 
Consult the respective sections in this User Manual plus the Instructions supplied with 
the device that causes the problem. 

No bus voltage 

Voltage too low 
throughout the network 

Certain devices  
are not read in 

Error code “141” 
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8 Files on the OCI600 
 

Applications > File transfer… takes you to the data administration of the OCI600. 
There are “Files on memory card” (for the “Offline trend” application) and “Files directly 
from central unit” for logging alarm events and user interventions. 

The File transfer… and Offline trend… applications are not available with all types of 
license packages. 

 

8.1 Files on the memory card: Offline trend files 
   

On the memory card, the 2 files OFFLINE.TRN and 00000001.SMO will be saved. These 
2 files are for exclusive evaluation with the Offline trend application. 

Using the ACS7... software, it is possible to define a number of data points in the 
OCI600 central communication unit whose values are periodically logged. The recorded 
data will be saved on the memory card and can then be opened and presented via the 
Offline trend application of the ACS7... software. Logging can take place offline, which 
means that there is no need for having a connection to the OCI600. 

For more detailed information about the Offline trend application, please refer to Online 
Help of the ACS7... under “Introduction to the Offline Trend application”. 

Due to the storage capacity of the memory card, the logging time is limited:  

d = number of selected data points 
m = capacity of memory card in Bytes 
s = sampling interval in minutes 

s
d
mT ⋅⋅= 16.0  

T = logging time in minutes 

d = 10 
m = 128 KB 
s = 15 min 

daysmin 30720s
d
mT 2115

10
12800016.016.0 ≅=⋅⋅=⋅⋅=  

 

Note on licenses 

Offline trend 

Logging time 

Example 
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8.2 Files directly from the central unit: Event files 
 

Events of parameterized inputs of the OCI600 (temperature, logic, digital and Batibus 
inputs) and the last 20 events of integrated controllers are also recorded in the event 
files and can later be evaluated by the user. 

Highlight the event file. Using the right mouse button, you can copy the file to the hard 
disk and open it. Menu item Extras > Options… > Tab: File transfer allows you to 
select a program that opens the file as standard. If you wish to do this, use MS Excel, 
for example. 

 

 

Procedure 
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Depending on the type of event files, different information is stored. Date and time of 
day of an event are always stored. 

Contents of information Recorded in file 
types 1) 

If the inputs are of the signalization type, the changes from the 
active to the inactive state, or vice versa, are recorded as an 
event with date and time of day 

OCI_LOGx.600 
OCI_DIGx.600 
DIGx_INx.600 

If the inputs are parameterized as alarm inputs, an entry with 
date and time of day is recorded for every attempt made to 
signal the alarm event. The entry designates the relevant phone 
nos. 

OCI_LOGx.600 
OCI_DIGx.600 
DIGx_INx.600 

If the inputs are parameterized as hours run counters, the time 
of day and date of input activation, as well as the time cumulated 
up to this point in time are recorded 

OCI_DIGx.600 
DIGx_INx.600 

The last 20 events per controller 1…16 that were defined in the 
device directory of the OCI600 are recorded 

REGx.600 

Crossing the temperature limit values at the inputs of the 
temperature sensors / adapters is recorded as an event. The 
current temperature and the information which of the 
temperature limit values has been crossed are stored 

TEMx_INx.600 

1) : 

REGx.600: Protocol files of the planned controllers (maximum 16) 

TEMx_INx.600: Protocol files of the inputs of the 2 temperature modules 

OCI_LOGx.600: Protocol files of the 4 logic inputs 

OCI_DIGx.600: Protocol files of the 4 digital inputs  

DIGx_INx.600: Protocol files of the 16 inputs of the Batibus input modules 

 

8.3 Up-to-dateness of files 
 

Regarding the up-to-dateness of the “Files on memory card” and the “Files directly from 
central unit”, following applies: 
• The directory is automatically uploaded when starting the File transfer application if, 

at this point in time, there is a connection to the central unit 
• The directory is automatically uploaded if the File transfer application has already 

been started and a connection to the central unit is then established 
• You can upload the directory at any time by clicking with the right mouse button on 

“Files on memory card”/ “Files directly from central unit” and choosing “Upload 
directory” 

You also find this information on up-to-dateness in ACS7... Online Help. 
 

Note on up-to-dateness 
of OCI600 files 
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9 Exchange of OCI600 device software 
 

Prior to exchanging the EPROMs, menu item Applications > Parameter settings … of 
the ACS7… software can be used to make a backup of the parameter settings. In that 
case, the parameter set is transferred to the PC and, after the exchange of the 
EPROMs, downloaded again to the OCI600. For more information about the 
Parameter settings application, refer to ACS7... Online Help. 

The OCI600 central communication unit has 2 EPROM plug-in spaces at the rear of the 
OCI600 operator unit. It must be made certain that the EPROMs, marked A and B, are 
plugged into the correct bases. 

AB

25
29

Z2
5

 
A, B Plug-in spaces  

 

When the software is updated by exchanging the EPROMs, the unit must be 
reinitialized. 
Reinitialization is triggered by pressing buttons  and  on the left and button 

 on the right before and at the instant power is switched on. 
In that case, all data are reset to their default values, which means that setting values 
that have already been parameterized will be lost. 

 

Backup of parameter 
settings 

Exchange of EPROMs 

Procedure 
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10 Addendum 
10.1 Batibus modules 
 

Since there is no documentation on the Batibus modules available, the following 
sections contain the key features regarding engineering, setting and commissioning.  
 

10.2 Input module DOE4IN 
 

The input module is used for acquiring the switching states of ancillary units and 
controllers not compatible with the LPB. Up to 4 input modules, each with 4 potential-
free contact inputs, can be connected to the LPB and queried via the OCI600 central 
communication unit.  
The function of the input module corresponds to that of the digital input modules of the 
OCI600 (status or alarm inputs). 
 

The input module mounts on DIN rails.  
The 2 setting knobs can be accessed after removing the transparent cover.  

1

2

3 4

25
29

Z2
9

 
1 Setting knob «famil.» for segment number 
2 Setting knob «no» for device number 
3 LED «trans.» for status indication  
4 LEDs for operating state of inputs 

 
If the DOE4IN input module is operated together with other Batibus devices, Batibus 
address collisions can occur. For this reason, a Batibus address calculation is made 
prior to making the settings. 

Based on the 2 settings, the address of the connected device or of the assigned 
apartment is calculated as follows:  
Address = ( f – 1 ) * 16 + ( n – 1 ) + ( Ex – 1 )  

where:  
f = segment number «famil.» 
n = device number «no» 
Ex = input number (E1 = 1, E2 = 2, E3 = 3, E4 = 4)  
 

f = 4 (segment 4)  
n = 1 (device 1)  
Ex = 1 (input 1) 

Batibus address =  
( f – 1 ) * 16 + ( n – 1 ) + ( Ex – 1 ) = ( 4 – 1 ) * 16 + ( 1 – 1 ) + ( 1 – 1 ) = 48  

 

On the input module, the following settings must be made: 
• Setting knob «famil.» is used for setting the segment address (recommended: 4). 

Function 

Mechanical design  

Batibus address 

Example  

Settings 
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• Setting knob «no» is used for setting the device number, which can be 1, 5, 9 or 13. 
This setting automatically assigns a number to each input.  
If, for example, setting «no» = 5, the following numbers will be assigned:  
Input E1 is given number 5  
Input E2 is given number 6  
Input E3 is given number 7  
Input E4 is given number 8  

To check the connection, the orange LED «trans.» flashes when in operation.  
The operating state of the 4 inputs is indicated by a green LED (LED lit = input active). 
  
 
L

N1

N 25
29

A0
3

AC
 2

30
 V

LPB

4

5

E1 E2 E3 E4
6 7 8 14 15 16 0 V

 
E1...E4 Inputs 1...4  
LPB Data bus 
N1 Input module DOE4IN 

 

10.3 Relay module DOE4RE 
  

The relay module is used for triggering a function, either manually or automatically, by 
closing a contact. Up to 4 relay modules, each with 4 potential-free contact inputs, can 
be connected to the LPB and operated via the OCI600 central communication unit.  
The function of the relay module corresponds to that of the OCI600 outputs. 
  
The relay module mounts on DIN rails.  
The 2 setting knobs can be accessed after removing the transparent cover. The relay 
selectors on the module front can be operated with a screwdriver.  

1

2

3 4 5

25
29

Z2
7

 
1 Setting knob «famil.» for segment number 
2 Setting knob «no» for device number 
3 LED «trans.» for status indication  
4 Relay selector  
5 LEDs for operating state of relay  
  

Notes on operation  

Connection diagram 

Function 

Mechanical design  
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If the DOE4RE relay module is operated together with other Batibus devices, Batibus 
address collisions can occur. For this reason, a Batibus address calculation is made 
prior to making the settings. 

 

Based on the 2 settings, the address of the connected device or of the assigned 
apartment is calculated as follows:  
Address = ( f – 1 ) * 16 + ( n – 1 ) + ( Sx – 1 )  

where:  
f = segment number «famil.» 
n = device number «no» 
Sx = relay number (S1 = 1, S2 = 2, S3 = 3, S4 = 4)  
 

f = 5 (segment 5)  
n = 1 (device 1)  
Sx = 1 (relay 1) 

Batibus address =  
( f – 1 ) * 16 + ( n – 1 ) + ( Sx – 1 ) = ( 5 – 1 ) * 16 + ( 1 – 1 ) + ( 1 – 1 ) = 64  

 
On the relay module, the following settings must be made:  
• Setting knob «famil.» is used for setting the segment address (recommended: 5)  
• Setting knob «no» is used for setting the device number, which can be 1, 5, 9 or 13. 

This setting automatically assigns a number to each relay.  
If, for example, setting «no» = 5, the following numbers will be assigned:  
Relay S1 is given number 5  
Relay S2 is given number 6  
Relay S3 is given number 7  
Relay S4 is given number 8  

• The selectors for the relays are to be set to «auto»  
 
To check the connection, the orange LED «trans.» flashes when in operation.  
The operating state of the 4 relays is indicated with a green LED (LED lit = relay 
energized). 
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